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Return-To-Factory Warranty
Psion Teklogix warrants a return-to-factory warranty for a period of one year. In
some regions, the warranty exceeds this period. Please contact your local Psion
Teklogix office for details. For a list of offices, please refer to Appendix A: “Support
Services And Worldwide Offices”. The warranty on Psion Teklogix manufactured
equipment does not extend to any product that has been tampered with, altered, or
repaired by any person other than an employee of an authorized Psion Teklogix
service organization. See Psion Teklogix terms and conditions of sale for full details.

Service
When requesting service, please provide information concerning the nature of the
failure and the manner in which the equipment was used when the failure occurred.
Type, model, and serial number should also be provided. Before returning any
products to the factory, call the Customer Services Group for a Return
Authorization number. 

Support Services
Psion Teklogix provides a complete range of product support services to its
customers. For detailed information, please refer to Appendix A: “Support Services
And Worldwide Offices”. 

Disclaimer
Every effort has been made to make this material complete, accurate, and up-to-
date. Psion Teklogix Inc. reserves the right to make changes without notice and shall
not be responsible for any damages, including but not limited to consequential
damages, caused by reliance on the material presented, including but not limited to
typographical errors.
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APPROVALS AND SAFETY SUMMARY

DECLARATION OF CONFORMITY

Product: netpad 1000 Series with Serial Docking Station

Application of Council Directives: EMC Directive: 89/336/EEC
Low Voltage Directive: 73/23/EEC

Conformity Declared to Standards: EN 55022: 1998; Class B;
EN 55024: 1998;

EN 61000-4-2; ±4kV CD; ±8kV AD
EN 61000-4-3; 3V/m, 80-1000 MHz, 900 MHz
EN 61000-4-4; ±1kV Power lines
EN 61000-4-5; ±2kV Common; 

±1kV Differential mode
EN 61000-4-6; 3VRMS, 150 kHz-80 MHz
EN 61000-4-11; AC Mains Ports

EN 61000-3-2; EN 61000-3-3
EN 60950: 1992 + A1 + A2 + A3 + A4 + A11

Manufacturer: PSION TEKLOGIX INC.
2100 Meadowvale Blvd.
Mississauga, Ontario; Canada L5N 7J9

Year of Manufacture: 2002

Manufacturer’s Address in the 
European Community: PSION TEKLOGIX S.A.

La Duranne; 135 Rue Rene Descartes
BP 421000
13591 Aix-En-Provence
Cedex 3; France

Type of Equipment: Information Technology Equipment

Equipment Class: Commercial and Light Industrial

Manufacturer: Psion Teklogix Inc. Ontario

Legal Representative in Europe: Psion Teklogix S.A. France
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DECLARATION OF CONFORMITY

Product: netpad 3000 Series with Serial Docking Station

Application of Council Directives: EMC Directive: 89/336/EEC
Low Voltage Directive: 73/23/EEC

Conformity Declared to Standards: EN 55022: 1998; Class B;
EN 55024: 1998;

EN 61000-4-2; ±4kV CD; ±8kV AD
EN 61000-4-3; 3V/m, 80-1000 MHz, 900 MHz
EN 61000-4-4; ±1kV Power lines
EN 61000-4-5; ±2kV Common; 

±1kV Differential mode
EN 61000-4-6; 3VRMS, 150 kHz-80 MHz
EN 61000-4-11; AC Mains Ports

EN 61000-3-2; EN 61000-3-3
EN 60950: 1992 + A1 + A2 + A3 + A4 + A11
EN 60825-1, AM.2: 2001; Laser Safety

Manufacturer: PSION TEKLOGIX INC.
2100 Meadowvale Blvd.
Mississauga, Ontario; Canada L5N 7J9

Year of Manufacture: 2002

Manufacturer’s Address in the 
European Community: PSION TEKLOGIX S.A.

La Duranne; 135 Rue Rene Descartes
BP 421000
13591 Aix-En-Provence
Cedex 3; France

Type of Equipment: Information Technology Equipment

Equipment Class: Commercial and Light Industrial

Manufacturer: Psion Teklogix Inc. Ontario

Legal Representative in Europe: Psion Teklogix S.A. France
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FCC INFORMATION FOR THE USA

FCC DECLARATION OF CONFORMITY (DOC)

Applicant’s Name & Address: PSION TEKLOGIX
2100 Meadowvale Blvd.
Mississauga, Ontario, Canada L5N 7J9
Telephone No.: (905) 813-9900

US Representative’s Name & Address: Psion Teklogix Corp.
1810 Airport Exchange Blvd., Suite 500
Erlanger, Kentucky, 41018, USA
Telephone No.: (859) 371-6006

Equipment Type/ Environment Use: Computing Devices for Home and Office Use

Trade Name / Model No.: netpad

Year of Manufacture: 2002

Standard(s) to which Conformity is Declared:

The netpad and Serial Docking Station, supplied by Psion Teklogix, has been tested and 
found to comply with FCC PART 15, SUBPART B - UNINTENTIONAL RADIA-
TORS, CLASS B COMPUTING DEVICES FOR HOME & OFFICE USE.

Applicant: Psion Teklogix Inc.
Mississauga, Ontario, Canada

Legal Representative in US: Psion Teklogix Corp.
Erlanger, Kentucky, USA
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CE MARKING
When used in a residential, commercial or light industrial environment the prod-
uct and its approved UK and European peripherals fulfill all requirements for 
CE marking.

R&TTE DIRECTIVE 1999/5/EC
This equipment complies with the essential requirements of EU Directive 
1999/5/EC (Declaration available: www.psionteklogix.com).

Cet équipement est conforme aux principales caractéristiques définies dans la 
Directive européenne RTTE 1999/5/CE. (Déclaration disponible sur le site: 
www.psionteklogix.com).

Die Geräte erfüllen die grundlegenden Anforderungen der RTTE-Richtlinie 
(1999/5/EG). (Den Wortlaut der Richtlinie finden Sie unter: 
www.psionteklogix.com).

Questa apparecchiatura è conforme ai requisiti essenziali della Direttiva Europea 
R&TTE 1999/5/CE. (Dichiarazione disponibile sul sito: www.psionteklogix.com).

Este equipo cumple los requisitos principales de la Directiva 1995/5/CE de la UE, 
“Equipos de Terminales de Radio y Telecomunicaciones”. (Declaración disponible 
en: www.psionteklogix.com).

Este equipamento cumpre os requisitos essenciais da Directiva 1999/5/CE do Parla-
mento Europeu e do Conselho (Directiva RTT). (Declaração disponível no 
endereço: www.psionteklogix.com).

Ο εξοπλισµός αυτός πληροί τις βασικές απαιτήσεις της κοινοτικής οδηγίας EU 
R&TTE 1999/5/EΚ. (Η δήλωση συµµόρφωσης διατίθεται στη διεύθυνση: 
www.psionteklogix.com)

Deze apparatuur voldoet aan de noodzakelijke vereisten van EU-richtlijn betref-
fende radioapparatuur en telecommunicatie-eindapparatuur 199/5/EG. (verklaring 
beschikbaar: www.psionteklogix.com).

Dette udstyr opfylder de Væsentlige krav i EU's direktiv 1999/5/EC om Radio- og 
teleterminaludstyr. (Erklæring findes på: www.psionteklogix.com).

Dette utstyret er i overensstemmelse med hovedkravene i R&TTE-direktivet 
(1999/5/EC) fra EU. (Erklæring finnes på: www.psionteklogix.com).
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Utrustningen uppfyller kraven för EU-direktivet 1999/5/EC om ansluten teleutrust-
ning och ömsesidigt erkännande av utrustningens överensstämmelse (R&TTE). 
(Förklaringen finns att läsa på: www.psionteklogix.com).

Tämä laite vastaa EU:n radio- ja telepäätelaitedirektiivin (EU R&TTE Directive 
1999/5/EC) vaatimuksia. (Julkilausuma nähtävillä osoitteessa:
www.psionteklogix.com).

Use of the 802.11 netpad in France:
Owing to French Government restrictions, the French 802.11 netpad is limited 
to indoor use. They may be used outdoors, on private property, only with prior 
authorization from the French Ministry of Defense.

FCC INFORMATION TO THE USER

RADIO AND TELEVISION INTERFERENCE 
This equipment radiates radio frequency energy and if not used properly—that is, 
in strict accordance with the instructions in this manual—may cause interference to
radio communications and television reception. It has been tested and found to com-
ply with the limits for a Class B digital device pursuant to part 15 of the FCC Rules.
Operation is subject to the following two conditions:

1. This device may not cause harmful interference, and 
2. This device must accept any interference received, including interfer-

ence that may cause undesired operation.

These limits are designed to provide reasonable protection against harmful interfer-
ence in a residential installation. However, there is no guarantee that interference
will not occur in a particular installation. If this equipment does cause harmful inter-
ference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one
or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation distance between the equipment and the receiver.
• If you are using the equipment with a mains adaptor, plug it into an outlet 

which is on a different circuit from that to which the receiver is connected.
• Consult an experienced radio/TV technician for help.
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For customers in the USA, the following booklet prepared by the Federal Commu-
nications Commission may be of help: “How to Identify and Resolve Radio-TV
Interference Problems”. This booklet is available from the US Government Printing
Office, Washington, DC 20402 - Stock No 004-000-00345-4.

RADIO FREQUENCY EMISSIONS

Do not use in aircraft or hospitals. Some equipment in hospitals and aircraft are not
shielded from radio frequency energy. Do not use the netpad onboard aircraft, or in
hospitals, without first obtaining permission.

Do not use near pacemakers. The product may affect the operation of some medi-
cally implanted devices such as pacemakers, causing them to malfunction. Avoid
placing your product next to such devices. Keep a minimum distance of 15 cm
between the device and the product to reduce the risk of interference. If you have
any reason to suspect that interference is taking place, turn off the netpad and con-
tact your cardiologist for assistance.

Note: In August 1996 the Federal Communications Commission (FCC) of the 
US adopted an updated safety standard for human exposure to radio fre-
quency energy emitted by FCC regulated transmitters. The design of this 
product complies with the FCC guidelines and those standards.

To maintain compliance with the FCC RF exposure guidelines, if you 
wear the netpad on your body, use the supplied or approved carrying 
case, holster, or other body-worn accessory (see page 13 for details). If 
you do not use a body-worn accessory, ensure the antenna is at least 1.5 
cm from your body when transmitting. Use of non-approved accessories 
may violate FCC RF exposure guidelines.

IMPORTANT SAFETY INSTRUCTIONS
This equipment was tested for FCC compliance under conditions that included the
use of shielded cables and connectors between it and the peripherals. It is important
that you use shielded cable and connectors to reduce the possibility of causing radio
and television interference. Shielded cables, suitable for the netpad, can be obtained
from an authorised Psion Teklogix dealer.
If the user modifies the equipment or its peripherals in any way, and these modifica-
tions are not approved by Psion Teklogix, the FCC may withdraw the user’s right to
operate the equipment.
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EMISSIONS INFORMATION FOR CANADA 
This Class B digital apparatus meets all requirements of the Canadian Interference-
Causing Equipment Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Règlement
sur le matériel brouilleur du Canada.

INFRARED DEVICE SAFETY
CLASS 1 LED PRODUCT

This product includes an Infrared device for transmitting and receiving files from
devices supporting the IrDA format. Although this invisible beam is not considered
harmful, and complies with EN60825-1 (IEC825-1), we recommend the following
precautions when the Infrared device is transmitting:

• Do not stare into the Infrared beam.

• Do not view directly with optical instruments.

No parts in the device may be serviced by the user.

INTEGRATED SCANNER SAFETY
For your own safety, it is critical that you comply with the warnings described in
“The Scanner” on page 23.

BATTERY SAFETY PRECAUTIONS
CAUTION!
Danger of explosion if a netpad battery is incorrectly handled, charged, disposed of
or replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Dispose of used batteries according to the instructions described in
“Lithium-Ion Battery Safety Precautions” on page xiv. Carefully review all battery
safety issues listed in that section.

VORSICHT!
Explosiongefahr bei unsachgemäßem Austausch der Batterie Ersatz nur durch
denselben oder einen vom Hersteller empfohlenen gleichwertigen Typ. Entsorgung
gebrauchter Batterien nach Angaben des Herstellers.
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LITHIUM-ION BATTERY SAFETY PRECAUTIONS
Do not store batteries at temperatures in excess of +60°C; the optimum storage tem-
perature for maximum battery life is +10°C to +35°C.

Important: It is critical that this safety information be reviewed and that all 
warnings be strictly followed.

BATTERIES ARE CONSIDERED HAZARDOUS WASTE. Used batteries must 
be disposed of in accordance with the manufacturer’s instructions, taken to an 
appropriate local battery recycling facility, or returned to one of the following Psion 
Teklogix offices for proper disposal. 

Teklogix Inc. Teklogix Corp. Teklogix S.A.
2100 Meadowvale Blvd. 1810 Airport Exchange Blvd. Parc Club Du Golf-Bat 1.
Mississauga, Ontario Suite 500 13856 Aix-En-Provence
Canada Erlanger, Kentucky Cedex 3
L5N 7J9 USA 41018 France

Warning: TO PREVENT the battery from leaking acid, generating heat or 
exploding, adhere to the precautions listed below.

• Use only with the authorized Psion Teklogix power adaptor.

• Do not dispose of in fire.

• Do not incinerate or subject battery cells to temperatures in 
excess of 100°C (212°F). Such treatment can vaporize the liquid 
electrolyte causing cell rupture. Incineration may result in 
harmful emissions or explosion.

• Do not charge, use or store batteries below -30º C (-22° F). Bat-
teries must be handled in accordance with all applicable state 
and federal laws and regulations.

• The battery incorporates built-in safety devices. To ensure their 
proper function, do not disassemble or alter any parts of the battery.

• Do not short-circuit the battery by directly connecting any of the 
exposed terminals with metal objects such as wire. Do not trans-
port or store the battery together with metal objects such as neck-
laces, hair pins, etc.
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• Do not use or leave the battery near a heat source such as a fire 
or heater.

• Do not immerse the battery in water.

• When charging, use the battery charger specifically designed for 
the battery.

• Do not crush, puncture, open, dismantle, or otherwise mechani-
cally interfere with batteries.

• Do not directly solder the battery.

• Do not connect the battery to an electrical outlet, vehicle ciga-
rette lighter, etc.

• Do not put battery into a microwave oven or pressurized container.

• Do not use the battery in combination with primary batteries 
(such as dry-cell batteries) or batteries of different capacities 
or brands.

• Immediately remove the battery from the device or battery 
charger and stop use if the battery gives off an odour, generates 
heat, becomes discoloured or deformed, or in any way appears 
abnormal during use.

• Do not continue charging the battery if it does not recharge 
within the specified charge time.

• The battery may burst or ignite if the battery leaks. Always 
ensure that it is away from any exposed flames.

• If a battery should leak, do not allow the contents to come into 
contact with your skin or your eyes. If it does, wash immediately 
with plenty of cold water and seek medical advice.

• Do not store the battery in extremely high temperatures (e.g., a 
vehicle, strong direct sunlight, etc.). This may cause the battery 
to overheat or ignite, and it may also reduce the performance 
and service life of the battery.

• Do not use in areas where static electricity is greater than what 
the manufacturer guarantees.

• Keep batteries out of reach of children.
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Chapter 1: Introduction
About This Manual

1.1  About This Manual
This manual provides information on the operation and features of the Psion 
Teklogix netpad. For additional information, refer to the netpad online help, or the 
documentation supplied with the application you are using. The manual references 
other user documents, where applicable.

Chapter 1: Introduction
provides an overview of this manual, netpad applications, including the PC con-
nectivity software, ActiveSync, and care of the netpad.

Chapter 2: Getting Started
describes the netpad features and how to get the netpad ready for use, including 
installation of the antenna, MMC, and SIM card. Important battery installation 
and use information is also detailed.

Chapter 3: Docking Station
details the use of the docking station. 

Chapter 4: Configuring The netpad
provides instructions on configuring the netpad’s screen rotation, security and 
Control Panel features. It also explains how to use ActiveSync to connect the 
netpad to a PC serially, or through Infrared or radio communication. File trans-
fers, file synchronization and sending e-mail can all be done via ActiveSync.

Chapter 5: Files, Folders, and Programs
describes the netpad’s file manager and how to move around and manage the 
information on your netpad.

Chapter 6: Connecting netpad To A PC
explains how to use ActiveSync for file transfers, file synchronization and 
sending e-mail. 

Chapter 7: Configuring Communications
instructs on the configuration of GSM/GPRS and 802.11 radios, and the programs 
Internet Explorer (the Internet browser) and Inbox (the e-mail application).

Chapter 8: netpad Accessories
describes the accessories that are available for the netpad, including the 
Charging solutions, In-vehicle Docking station, and carrying cases.

Chapter 9: Troubleshooting the netpad
assists in the recognition and correction of problems that you may encounter 
when operating the netpad and ActiveSync.



Chapter 1: Introduction
Text Conventions

4 Psion Teklogix netpad Win CE 4.1 User Manual

Appendix A: Support Services And Worldwide Offices
presents information for technical support, contacts and the Psion Teklogix 
worldwide web address.

1.2  Text Conventions
Note: Notes highlight additional helpful information.

Important: These statements provide particularly important instructions or 
additional information that is critical to the operation of the 
computer and other equipment.

Warning: These statements provide important information that may prevent 
injury, damage to the equipment, or loss of data.

1.3  Applications Installed On The netpad
The netpad is capable of running a wide variety of applications but the ones 
available on your particular netpad depend on the purpose for which the netpad is 
provided. A number of standard applications exist and custom programs can be 
installed easily.

The following standard programs are available:

• Wordpad, a word processor for writing letters and other documents.

• Inbox, for sending and receiving e-mail.

• Internet Explorer, for browsing the World Wide Web.

• Calculator, a calculator with general features.

1.3.1  About ActiveSync
The Microsoft PC connectivity software, ActiveSync, can be used to connect the 
netpad to PCs running Windows 95/98/2000/ME or NT 4.0. By connecting the 
netpad to a PC with a cable and running ActiveSync on the PC, you can:

• View your netpad files from Windows Explorer by using the Mobile 
Device icon in the PC’s My Computer window.
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• Drag and drop files between the netpad and the PC in the same way that 
you would between PC drives, and they will be automatically converted to 
the appropriate file format at the same time.

• Synchronize e-mail and your address book on the netpad with the PC to 
keep them in step with each other.

• Back up your netpad files to the PC, then restore them from the PC to the 
netpad again, if needed.

For detailed information, please refer to Chapter 6: “Connecting netpad To A PC”.

1.4  Caring For The netpad
Screen
When used with the approved stylus, the netpad screen is very resistant to wear and 
impact and should last for a considerable time. Use of any object, other than the 
approved stylus, may result in damage to the netpad screen. 

To maintain the life of the netpad screen, keep the screen clean. To clean the screen: 
switch off the netpad and use a soft, clean, dry cloth to gently wipe the screen. (If the 
netpad is set to turn on automatically when the screen is tapped, you should turn this 
preference off before cleaning the screen.)

Warning: Under no circumstances use chemical solvents to clean the screen.

Charging
To avoid damage to the netpad or the netpad battery packs, use only Psion Teklogix 
approved chargers and docking stations.

Backup Battery
The netpad has a rechargeable backup battery designed to retain data while the main 
battery pack is charging or changed over.

The backup battery is trickle charged from the main battery pack and has a limited 
lifespan. To maximize the life of the backup battery, avoid excessive discharging and 
recharging of the backup battery by keeping the netpad battery pack fully charged.

Important: It both the main battery pack and the backup battery are allowed 
to fully discharge, all user data held in RAM will be lost.
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The backup battery is not user replaceable. If the backup battery requires replace-
ment the netpad must be returned to a Psion Teklogix approved service centre.

Drop Rating
The netpad is designed to survive being dropped on any face, onto concrete, from a 
height of 1.5 m (5 ft.).

Dropping the netpad from greater heights or onto harder surfaces may result in 
damage to the netpad.

IP Rating
The netpad is rated to IP67 and can survive submersion in water to a depth of 1 m 
(3.3 ft.) for up to 30 minutes. Submersion below this depth or for longer periods 
may result in damage to the netpad. 

Operating Temperature
The netpad is designed to operate within the temperature limits of -20°C to +60°C 
(-4°F to 140°F); and -20°C to +55°C (-4°F to 131°F) for scanner variants. Use of the 
netpad outside of these temperature limits may reduce its life. 

Avoid exposing the netpad to sudden changes in temperature, since such exposure 
may result in damage.

Important: As a safety precaution, charging the netpad battery should be 
limited to the temperature range: -20°C to +60°C (-4°F to 140°F); 
and -20°C to +55°C (-4°F to 131°F) for scanner variants. Outside 
of these limits, the safety circuits of the netpad battery pack will 
not allow the battery to charge. 

Storage Temperature
The netpad is designed to be stored within the temperature ranges of -25°C to +70°C 
(-13°F to 158°F); and -25°C to +60°C (-13°F to 140°F) for scanner variants. Storage 
of the netpad outside of these temperature limits may reduce its life. 

To prolong the life of the netpad battery packs during normal storage, store the 
netpad (and the battery pack) between +10°C and +35°C (+50°F and +95°F).

When storing the netpad for a long period of time, the main battery should be 
removed and stored fully discharged.
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Humidity
The netpad is designed to operate in humidity ranging from 0 to 95%. Use of the 
netpad in environments with condensing humidity or humidity outside these limits 
may result in damage to the netpad.

Magnetic Fields And Static Electricity
The magnet of the netpad speaker may corrupt data stored on magnetic media. Do 
not keep the netpad next to credit cards or other magnetic media. 

Avoid exposing the netpad to strong magnetic fields or static electricity. Such expo-
sure may cause loss of data or result in damage to the netpad.

Service
Do not attempt to dismantle the netpad. There are no user-serviceable parts inside, 
and any attempt to dismantle the netpad will invalidate the warranty.

1.5  Additional Programs And Third Party Applications
Psion Teklogix has partnered with a number of companies to provide a suite of con-
nectivity and database tools for the netpad. Details are available on the Psion Tek-
logix Partner Program web site at: http://partners.psionteklogix.com/partners/.
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Features Of The netpad

2.1  Features Of The netpad
This netpad is a Windows CE.Net OS-based mobile tablet computer with a 
1/2 VGA touch-sensitive screen. netpad is lightweight, shock and water-resistant, 
and designed for use in a wide range of business areas including field service, field 
sales, transport, health care, hospitality, manufacturing and insurance. It is available 
in variants with internal GSM/GPRS, 802.11b radios and scanners. 

Figure 2.1 netpad Front 

Figure 2.2 Back Of netpad
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Figure 2.3 Scanner Location

2.2  Preparing The netpad For Use
2.2.1  Fitting The Antenna
Before using netpad units fitted with either the GPRS or 802.11 radio, the antenna 
must be installed. The antenna should be installed as shown in Figure 2.4 below. To 
install the antenna turn it counter clockwise; to remove the antenna turn it clockwise. 

Figure 2.4 Antenna Insertion And Removal

Scanner Window
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2.2.2  Use Of The Soft Belt Holster

Figure 2.5 Insertion Of netpad In Holster

Important: The netpad and holster have been tested to ensure compliance with 
the latest FCC RF exposure guidelines. For continued compliance 
when using the netpad and holster combination, the face shown 
should be fitted against the body! The user must not modify the 
holster in any way.

Figure 2.6 Holster Position On Body
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2.2.3  Power Management
The netpad is powered by a Lithium Ion rechargeable battery pack, which under 
optimal operating conditions will provide power for a full shift. The netpad will 
warn you when the main battery charge is low. 

Note: How long your batteries last will depend upon how you use your netpad. 
The netpad will use considerably more battery power when you are 
recording sounds, have the brightness turned up, are using files stored on 
a multimedia card, or are using Infrared.

You can take steps to help prolong your battery’s life: 

• Turn the screen brightness down.
• Set automatic switch-off in the Power control panel.
• Use files on the internal disk instead of an MMC, as the netpad requires 

more power to write to the multimedia card.
The netpad can be powered from AC when used in the docking station (see page 31). 
When the netpad is powered from the docking station, it will also charge the 
battery pack. 

2.2.3.1 Fitting The Battery
Before you can use the netpad you must fit the battery—slide it into place until it 
clicks, as shown in Figure 2.7.
Important: Always switch off the netpad before removing the main battery.

Figure 2.7 Battery Insertion

Battery Pack
Direction of
Insertion

Battery
Latch

Battery Contact Pins
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Important: Take care when replacing batteries!

The netpad will warn you when its main battery is getting low, in 
plenty of time to change/charge it. The backup battery is designed 
to maintain the memory for several hours. However, prolonged reli-
ance on the backup battery does reduce its life. 

2.2.3.2 Charging The netpad Battery Pack
To charge the battery, attach the battery pack to the netpad and place the complete 
netpad in a netpad docking station (for instructions, please refer to page 31), or place 
the battery in one of the optional battery chargers. The standard (850 mAH) netpad 
battery will normally be fully charged within 2 to 2.5 hours (3 hours for a 1400 
mAH battery pack).

2.2.3.3 How Do I Check The Battery Power?
To check the battery power, open the Battery icon from the Control Panel. The 
Battery tab gives a brief description of the state of the main battery.

2.2.3.4 Changing Battery Packs
If you are using your netpad away from the charger and a spare battery pack is avail-
able, you can change batteries when the battery warning is displayed. To do this:

1. Switch the netpad off.

2. Press on the battery pack latch to remove it.

3. Push in the replacement battery pack.

Important: Always switch off the netpad before removing the main battery. 
Never remove the battery from the netpad while it is in the 
docking station. Never use a netpad without a battery in the 
docking station.
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2.2.3.5 Prolonging Battery Life
When your netpad is switched off, it is on “standby” and will continue to use a small 
amount of battery power. If you are going to leave your netpad switched off for a 
long period of time, you are advised to back up your data beforehand because the 
batteries will eventually run out.

Note: To check the battery power, open the Power icon from the Control Panel.

2.2.3.6 Internal Backup Battery
The netpad has a rechargeable backup battery designed to retain data while the main 
battery pack is charging or changed over. The backup battery is trickle charged from 
the main battery pack and has a limited lifespan. To maximize the life of the backup 
battery, avoid excessive discharging and recharging of the backup battery by 
keeping the netpad battery pack fully charged. 

Important: If both the main battery pack and the backup battery are allowed 
to fully discharge, all user data held in RAM will be lost.

The backup battery is not user replaceable. If the backup battery requires replace-
ment, the netpad must be returned to a Psion Teklogix approved service centre.

Important: If both the batteries run out of power you will lose all your infor-
mation on the internal disk.

2.2.4  Multimedia Cards
Multimedia cards (MMCs) are non-volatile memory cards, which fit into a dedi-
cated slot in the netpad and can be used to store application software and/or data. 

The MMC slot is located on the right-hand side of the netpad (see Figure 2.8 on 
page 17). 

2.2.4.1 Inserting And Removing An MMC
• Open the card slot door located on the side of the unit by sliding the retain-

ing latch. Push the MMC into place until it clicks. Close the door.

• To remove an MMC, open the door and push the card. Store your MMC 
safely, particularly if it contains valuable data.
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Figure 2.8 MMC Slot Location

2.2.5  Installing And Removing The SIM Card
A netpad fitted with a GSM/GPRS radio requires a Subscriber Identity Module 
(SIM) card installed in order for the netpad to access the GSM network. The SIM 
card fits into a dedicated slot in the netpad. The SIM card slot is located behind the 
Card Slot door on the right-hand side of the netpad; and is located below the Multi-
media card (MMC) slot (see Figure 2.9). 

Figure 2.9 Location Of SIM Card And MMC

Important: The MMC slot and SIM card slot are located very close together. 
When inserting or removing the SIM card be careful not to drop 
the SIM card into the MMC slot.

Card Slot Door Latch

MMC Card

Reset
Button

SIM Card

MMC

Card Slot Door

(screen side up)
Orientation of netpad
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2.2.5.1 Inserting The SIM Card
Warning: To prevent damage to the SIM card, ensure that the netpad is 

switched off and the battery removed before inserting the SIM card.

• Remove the battery pack from the netpad.

• Open the card slot door located on the side of the unit by sliding the retain-
ing latch. 

• Push the SIM card into place until it is fully inserted. Note the orientation of 
the card, shown in Figure 2.10, with the notch of the card on the left, trailing 
side. The cross-hatching on the card will be facing down.

• Close the door.

Figure 2.10 Insertion Of SIM Card

Important: Ensure that the SIM card is inserted in the correct orientation as 
shown. Once inserted, the SIM card can only be removed using a 
pair of tweezers or long-nosed pliers.

If the SIM card is inserted incorrectly, the unit will not connect to 
the GSM network. If the SIM card is inserted incorrectly, it must 
be removed by following the instructions to remove the SIM card 
(see “Removing The SIM Card” on page 19).

MMC

SIM Card

SIM Card SlotOrientation of Card
(notched corner)
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2.2.5.2 Removing The SIM Card
Warning: To prevent damage to the SIM card, ensure that the netpad 

is switched off and the battery removed before removing the 
SIM card.

• Open the Card Slot door and grasp the card on the cross-hatch area (see 
Figure 2.11), using the special removal tool supplied, a pair of tweezers, or 
long-nosed pliers. Pull the card out carefully.

Figure 2.11 Removal Of SIM Card

MMC

Orientation of netpad

Cross-hatched Area of SIM Card

(screen side down)

(grip here with pliers)
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2.3  Turning On And Off
To switch on: 

press the On/Off button on the top.

Note: If the serial cable is connected to the PC and the netpad, the netpad will 
automatically switch on when ActiveSync on the PC is searching for a 
connection.

To switch off: 
press the On/Off button to turn off the display. Press and hold to suspend the 
netpad. You can switch off at any time. You do not have to save your informa-
tion first, as it is automatically saved for you. If you are working with a file on 
the MMC, save the file before switching off the netpad and removing the card.

Note: If you do not use the netpad, it will automatically switch off after a few 
minutes to save battery power. To continue using the netpad where you left 
off, switch the netpad on again using the On/Off button. The power saving 
options are available via the Control Panel. The automatic switch-off time 
may have different settings, depending on whether the netpad is in the 
docking station or not. The automatic switch-off can also be configured to 
suspend or turn off the display.

2.4  Finding And Using The Stylus
The stylus is located in a holder at the right. To remove it, slide the stylus out of the 
top of the netpad. To replace it, push it back in. Tap lightly on the screen using the 
stylus. You can use your fingers to tap on the screen, though it is best to use the 
stylus to avoid fingerprints or smudges on the screen. Do not tap the screen with any 
object that has a sharp tip or you may damage the screen. Don’t use any type of ink 
pen, as the ink may be impossible to remove. See “Caring For The netpad” on 
page 5 for instructions on how to clean the screen.
You can usually tap on (“click on”) an item with the stylus to select or change it. For 
example, you can:

• Double-tap (or click) a program icon, to open a program.
• Single-tap (or click) the soft keys, for “shortcuts” to system functions.
• Tap-and-hold to right-click. Right-clicking can interrupt the functionality of 

other tap-and-hold items, such as scrollbars.
Note: If the screen doesn’t respond to your taps, you may need to re-calibrate it. 

You can do this by holding down the On/Off button for 3 seconds.
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2.5  The Screen, Command Icons, And Toolbar
The netpad screen has a column of permanent “command icons” on the right-hand 
side. Some of these are user-configurable via the Soft Keypad Settings icon in the 
Control Panel.

From top to bottom, the defaults for these soft keys are:

Start Menu:
This icon is user-definable.Left-clicking displays the Control Panel. 
Right-clicking displays the command shell.

Backlight control: 
Left-clicking displays the Brightness/Contrast control panel. Right-
clicking is inactive.

Important: Battery life is considerably reduced when the brightness 
is increased.

Explorer:
This icon is user-definable. Left-clicking displays the Windows 
Explorer. Right-clicking displays Internet Explorer.

Keyboard: 
Left-clicking displays the Software Input Panel (SIP), the on-screen 
keyboard. Right-clicking is inactive.

System command icon:
Left-clicking displays the Start Menu. Right-clicking displays the Soft Keypad 
Settings control panel.

2.6  How To Reset The netpad 
If you find that you cannot exit a program normally, right-click on the taskbar and 
select Task Manager from the context menu. Select the task that appears to be unre-
sponsive and click on the End Task button.

If this does not work, or if your netpad appears to have “locked up”, you can always 
perform a “soft reset”. This should restart your netpad while preserving most of 
your information. It is worth trying a soft reset if the keys on the netpad do not 
appear to respond, or if the netpad appears to switch on and you are sure that the bat-
teries are good, but the screen is otherwise blank.
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To perform a soft reset: 
gently press the stylus onto the reset button. This is located inside the card slot 
door cover to the side of the MMC slot.

Figure 2.12 Reset Button Location
Press the On/Off button to restart the netpad—you will hear two beeps during boot-
up to indicate the reset. After a soft reset, any changes to open files will be lost. Your 
other files on the internal disk will almost always be safe. It is possible (although 
unlikely) that performing a soft reset after a program failure may cause the netpad to 
lose the information on the internal disk; it could even prevent the reset from 
working at all. If this happens, you will have to perform a “hard reset”.

Important: A hard reset resets the netpad completely, and all information on 
the internal disk will be lost.

To perform a hard reset: 
1. Remove the netpad from the docking station (if applicable).
2. Remove the main battery.
3. Press and hold down the On/Off button (on the top of the unit).
4. While continuing to hold down the On/Off button, press and release the 

Reset button. 
5. Release the On/Off button.
6. Refit the battery into the netpad—the unit will power up and you will hear

one beep during boot-up.

Note: Hard resetting the netpad will delete the partnership on the netpad. You 
may delete and re-create the partnership on the PC, or create another 
partnership with a new name. Refer to ActiveSync’s online help for more 
details on this operation.

MMC

SIM Card

Reset Button



Psion Teklogix netpad Win CE 4.1 User Manual 23

Chapter 2: Getting Started
The Scanner

2.7  The Scanner
Where fitted with a bar code scanner, the netpad may be used to read industry 
standard bar codes. To scan a bar code, point the scanner window at the bar code, 
ensuring that the scanner window is not obstructed and that you are between 5 cm (2 
in) and 60 cm (24 in) from the bar code. Activate the scanner as instructed in the 
software application’s operating instructions. The scanning beam should be ener-
gized until a successful decode is achieved or three seconds have elapsed.

Figure 2.13 Scanner Location

Warning: For your own safety, it is critical that you comply with the 
following warnings:

1.Do not look into the scanner window.
2.This product contains a laser scanner that emits less than 1.2 mW 

average radiant power at a wavelength of 650 nm. This product 
complies with 21 CFR 1040.10, 1040.11 and DIN EN 60825-1: 
January 2001, and is classified as a Class 2 laser product.

3.CAUTION – Using controls or adjustments, or performing proce-
dures other than those specified herein may result in hazardous 
radiation exposure.

4.CAUTION – The use of optical instruments with this product will 
increase eye hazard.

Scanner Window
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2.8  First Steps
When you first switch on the netpad, you will see the Calibration screen. You must 
calibrate successfully to continue. After calibration, you will see the Time/Date 
control panel. Input the correct time, date, and time zone information. Click the OK 
button in Time/Date control panel to close and save your changes. You will then see 
the Windows Desktop.

2.8.1  Navigating Between Files And Folders
• Double-click on a folder icon to open that folder. Click on the X icon to 

close it. Click on the Up Folder icon to move back up one level.

• Click on a file to select it. Double-click to open it.

2.8.2  Starting Programs
When you open a file, the correct program for this file is started automatically. You 
can also start programs by clicking on them from the Start Menu. You don’t have to 
close one program before opening another. The taskbar displays all open applications.

Up Folder
X icon
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2.8.3  Programs And Files
To create a new file: 

open the program, select the New command on the File menu and type in the 
name for the new file (see “Entering Information”, below). The file will now be 
created. You can start entering your information.

It is a good idea to keep related files together in a folder, to make the files easier to 
find later.

2.8.4  Entering Information
You can enter information and complete tasks using the stylus or the on-screen 
keyboard. The on-screen keyboard is displayed by clicking the Keyboard  
soft key.

To move the keyboard, drag it by the title bar.

To display and set the keyboard preferences, go to the Control Panel and open the 
Input Panel icon. Clicking on the Options button will let you set such preferences 
as button size and special gestures for use with the keyboard.

Note: The on-screen keyboard is the netpad’s default keyboard. It is possible 
that your netpad may have more than one keyboard, if you have third-
party software installed. To choose which keyboard to use, go to the Con-
trol Panel and click on the Input Panel icon. The dropdown menu will 
show all available keyboards.
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2.8.5  Using Menus
You can usually select a menu command to perform tasks.

• Click on the menu you want to access from the menu bar.
• Tap on the menu names and commands, or use the arrow keys to move 

around the menus. Tap on commands marked with a  or press the right 
arrow key to see further commands.

A menu command with three dots at the end means that selecting the command will 
display a “dialogue” where you enter more information (see “Using Dialogues”, 
below).

If a menu command is grey, it means that it’s not currently available; e.g. you cannot 
Copy unless you have first selected something to copy.

2.8.6  Using Dialogues
A “dialogue” appears when you need to make selections and enter further informa-
tion. You can move between dialogue items by tapping on them, or using the up and 
down arrow keys. Dialogues contain one or more of the following elements:

Textbox: 
where you just type in your information. When you tap in the textbox, you will 
need to open the on-screen keyboard to enter text.

Dropdown: 
where you select from a number of options. You will see left and right arrows 
around the current selection; you can change the selection by tapping on the 
arrows, by pressing the left and right arrow keys, or by typing the first letter of 
the option you want.

Checkbox: 
where you make a choice between selecting an option or not selecting it. Just 
tap on the checkbox, or press the left and right arrow keys to add or remove
a checkmark.

Radio buttons: 
where you make one choice from a number of options. Just tap on an option, or 
use the left and right arrow keys to make a selection.

If an item is grey, it is currently not available. For example, if you do not have a 
transflective display, the Backlight On checkbox in Backlight Properties will be 
greyed out.
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Some dialogues comprise a number of “pages”, each page has a “tab” at the top. Tap 
on the tab, or move the highlight to the tab name, to go to that page. You can also 
move a dialogue around the screen by holding the stylus on the dialogue title bar and 
dragging it across the screen.

2.8.6.1 Dialogue Buttons
Dialogues usually include standard buttons such as Ok and X. Some buttons have a 
standard keypress equivalent:

• Usually, you can tap the OK button or press the Enter key if you want to 
save information and remove the dialogue.

• Tap the Cancel button, the X button, or press the Esc key if you want to 
close the dialogue without saving the information.

• For dialogues that ask a question, you can tap the Yes button or press the Y 
key for ‘yes’; tap the No button, press the N key, or press the Esc key for ‘no’.

2.8.7  Copying Information Between Programs
You can insert information created in one program into a different program. 
For example, you may want to compose text in Wordpad before copying it into 
an e-mail message in the Inbox. If you try to insert an object into a program that is 
not designed to handle that type of object, you will be unable to Paste. Trying to 
copy a file from Windows Explorer into a Wordpad document will not work because 
Wordpad will keep the Paste option greyed out until it detects that text is ready to 
be pasted.

DropdownCheckbox

Tabs in dialogue page
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3.1  Using The Docking Station
This chapter describes the docking station. The docking station is used as a conve-
nient “drop-in” holder for the netpad, supplying power and communications through 
the docking station connector.

3.1.1  Docking Station
The netpad docking station provides a permanently connected holder for the netpad. 
The power jack is on the front and the serial communication sockets are situated at 
the right of the docking station. The connector to the netpad faces upwards from the 
middle of the station. This connector mates with the connector on the underside of 
the netpad, and provides both power and serial communications.

Place the netpad in the docking station and it will begin charging.

Figure 3.1 Docking Station Features
To insert the netpad into the docking station, align the two devices, and press down 
on the netpad until the connection is made. To eject, press down on the release 
button at the top of the docking station. The netpad will be pushed up and out of the 
docking station.

netpad Connectors Communication Ports

Power Jack

IR Ports
Release Button

Yellow LED indicates 
communications

Red LED indicates charging/
Green LED indicates charged

Red LED indicates power
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While the netpad is in the docking station, the communications port on the netpad can 
still be used. The docking station communications port is available for convenience.

You can rotate the orientation of the docking station on its stand. Hold the top of the 
docking station in one hand and the bottom in the other. Lift the top part to release it 
and rotate through 90°. When you let go of the top part, it will click into place.

3.1.2  Communications Settings
When performing PC communications, it is necessary to define the communication 
settings.

In the PC Connection icon in the Control Panel, verify that the checkbox that 
allows connection to the desktop is checked.

• Serial Port 3 specifies using the RS232 communications port on 
the netpad. 

• Docking Station specifies using the RS232 communications port on the 
docking station.

• Infrared Port specifies using the IR port on the back of the netpad.

To change the connection type, click on the Change... button and select the connec-
tion from the dropdown list.
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4.1  Things To Do First
This section describes what you may need to do to set up your netpad:

• Customize the screen rotation of the netpad.

• Enter owner information in the Owner control panel, so that your netpad 
can be returned if you lose it.

• Set a password for your machine, so that other people cannot access 
your information.

• Set the current time and date.

4.1.1  Screen Rotation
Screen rotation on the netpad is accessed from the Rotate icon  found on the 
Windows taskbar. To rotate the screen, click on the Rotate icon. It will rotate the 
screen in 90° increments.

Rotation is not fully supported by some programs. For instance, Windows Explorer 
should be closed and re-opened after rotation, otherwise the scroll bars will not 
redraw correctly. 

In auto-hide mode, the taskbar may not be properly displayed after rotation. Menus 
on icons in the system tray should not be activated before the screen is rotated. 
Menus should be closed before rotation.

Warning: Some applications do not support screen rotation and rotating the 
screen may cause some programs to become difficult to use. 

Some programs, such as Control Panel, may not support rotation 
at all.
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4.1.2  Entering Owner and Password Information
It is a good idea to enter “owner information”, so that if the netpad is lost, it can be 
returned when found:

1. Select the Owner icon from the Control Panel. Fill in all the fields on 
the Identification tab. Click OK to save your information.

2. Select the Password icon from the Control Panel. Enter a password in 
the first textbox and confirm it by typing it again in the second textbox. 
The text will be displayed as an asterisk (*) for security.

3. Click Suspend if you want to display the password request screen 
when switching the machine on after a suspend.

Click WarmBoot if you want to display the password request screen 
only when the machine has been warm-booted.

4. Click OK to save your changes.

Note: The system password does not protect files stored on multimedia cards or 
files copied to other machines. However, when connecting via ActiveSync 
to a unit that is password protected, you will be asked to enter the pass-
word on the PC.

Important: Don’t forget your password! If you have forgotten the system pass-
word then you will have to reset the machine. All the files stored on 
the internal disk will then be lost.

4.1.3  Setting The Time, Date And Time Zone
1. In the Control Panel, open the Date/Time icon. The Date/Time control 

panel is also accessible by double-clicking on the system time in the 
system tray.

2. You will see a dialogue in which you can set the time, date, and time 
zone. Move the highlight in the date box by tapping on the correct date. 
Use the arrow buttons to change month and year. In the Current Time 
box, type in the time or use the up and down arrows to set the time.

3. Click on the OK button and the time and date are saved.
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4.2  Things To Do Next
This section gives a brief overview of what else you may want to do when you first 
use your netpad.

4.2.1  Setting Up ActiveSync
ActiveSync allows you to connect the netpad to a PC serially, or through Infrared or 
radio communication. File transfers, file synchronization and sending e-mail can all 
be done via ActiveSync.

ActiveSync must be connected serially at least once before other connection types 
are possible. To use ActiveSync with the netpad:

• ActiveSync 3.5 should be installed on your PC.

• Attach the netpad ActiveSync serial cable to the communications port on 
your computer (usually COM1).

• Attach the other end of the serial cable to the netpad port labelled RS-232.

• On the netpad, go into the Control Panel and open PC Connection. Verify 
that the checkbox is checked and that the unit will connect using Serial 
Port 3.

• On the PC, configure the Connection Settings in ActiveSync to use the 
communications port to which you have attached the serial cable. The 
ActiveSync icon in the system tray should be green and the arrows should 
be rotating, indicating the PC is trying to establish a connection.

• On the netpad, click on the Start button, then Programs, then ActiveSync, 
and select direct from the ActiveSync menu. This should bring up a dia-
logue box indicating that the netpad is attempting to connect.

• A successful connection will be indicated by a blue icon in the netpad’s 
system tray. The netpad and the PC will also play sounds to indicate that 
they are connected, if sound is enabled on the devices.
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4.2.1.1 Partnerships
There are two types of connection provided for by ActiveSync:

1. Guest - A guest connection allows file transfers. No synchronization is 
performed. If the netpad is password protected, the password prompt 
will appear when connecting as guest.

2. Partnership - A partnership connection allows for synchronization of 
files, e-mail and other data. If the netpad is password protected, a pass-
word prompt will appear before allowing synchronization. It is neces-
sary to establish a partnership before trying to connect to ActiveSync 
via Infrared (IrDA) or Ethernet.

3. To Disconnect - You can disconnect any ActiveSync connection by 
double-clicking on the blue icon in the netpad’s system tray and select-
ing the Disconnect button from the dialogue
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4.2.1.2 Connecting With Infrared (IrDA)
To connect using ActiveSync via Infrared, a partnership must already be established 
between the PC and the netpad (see “Creating The Partnership” on page 59).

1. On the PC, open ActiveSync and go to the Connection Settings 
screen. The first checkbox concerns both serial and IrDA connections. 
Set the dropdown to use the Infrared connection.

2. On the netpad, go into Control Panel and open PC Connection. Make 
sure the checkbox is checked. Make sure it will connect using the Infra-
red Port. If this is not the case, click on the Change button and set the 
dropdown to the correct connection type.

3. Align the IrDA port on the netpad with the IrDA port on the PC. Infra-
red requires a clear path between ports. Make sure nothing is blocking 
the Infrared ports.

4. On the netpad, click on the Start button, then Programs, then Active-
Sync, and select direct from the ActiveSync menu.

4.2.1.3 Connecting With Ethernet (802.11)
To connect using ActiveSync via Ethernet, a partnership must already be established 
between the PC and the netpad.

1. On the PC, open ActiveSync and look at the Connection Settings 
screen. Uncheck all checkboxes except Ethernet.

2. On the netpad, go into Control Panel. Open Network and Dial-up 
Connections. Open the Properties for the network connection by 
double-clicking on the icon.

3. Click on the Name Servers tab and fill in the WINS information. If 
your network does not have a WINS server, you must set this informa-
tion to use the IP of your PC. If you do not know this information, 
please contact your system administrator.

4. Click on OK to save the network settings.

5. On the netpad, click on the Start button, then Programs, then Active-
Sync, and select wireless from the ActiveSync menu.
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Important: You must have a correctly configured access point to use 802.11 
Ethernet to access your PC via ActiveSync. The PC and the 
netpad must be on the same network, or networks that have access 
to each other, for this to function correctly.

4.2.2  Connecting netpad To The PC Using ActiveSync
• Connect the cable to the serial port on the netpad, and the other end to a 

serial port at the back of the PC.

• When you have installed ActiveSync on the PC, the ActiveSync icon will 
appear in the PC’s system tray. For details on how to use ActiveSync, refer 
to Chapter 6: “Connecting netpad To A PC” and see the ActiveSync online 
help.

• To connect to the netpad, set the Connection Settings in ActiveSync on the 
PC to accept connections on the serial port (for further details refer to
“Setting Up ActiveSync” on page 37). 

• On the netpad, check PC Connections in Control Panel to verify that it is 
set to allow connections, and that it is set to the correct port (usually Serial 
Port 3).

• On the netpad, click on the Start button, then Programs, then ActiveSync, 
and select direct from the ActiveSync menu to initiate the connection. If a 
dialogue does not appear on the netpad, the PC Connections are not set
correctly.

Backing Up To A PC
You can use ActiveSync to back up individual files, folders, or the netpad’s entire 
disk to the PC. It is possible to configure ActiveSync to automatically back up the 
netpad every time it synchronizes.

4.2.3  Backing Up To Multimedia Cards
You can back up individual files, individual folders or groups of files and folders to 
a multimedia card fitted in the multimedia card (MMC) slot. To back up the files 
and folders, copy them from the internal disk to a multimedia card using the Copy 
and Paste commands in the System screen.

1. Select the files and folders you want to back up, then select the Copy 
command from the Edit menu.



Psion Teklogix netpad Win CE 4.1 User Manual 41

Chapter 4: Configuring The netpad
Exploring The Control Panel

2. Set the current folder to be the Storage Card (i.e. the multimedia card).
3. Select the Paste command from the Edit menu.

Restoring Files From A Backup
To restore the files and folders on a multimedia card to your netpad, copy them from 
the multimedia card to the internal disk in the same way as backing up. This time, 
set the current folder to the Storage Card to select the files on the multimedia card, 
then change it to a folder on the netpad to paste the copied files to the internal disk.

4.2.4  Exploring The Control Panel
To display the Control panel: 

click on the Menu soft key, or select Control Panel from the Start, then Settings 
menu.

Initially, Date/Time should already be set, and possibly Password and PC Connec-
tions as well.You may wish to change other settings later. Some of the other options 
include:

• Use the Regional Settings icon to change settings that may vary from 
country to country, e.g. the currency and date formats.

• Use the Power icon to control how and when the netpad switches on and 
off. For example, you might like it to switch on when you click the screen, 
and off when you haven’t used it for three minutes.

• Use the Volume & Sound icon to control the sounds that the netpad makes 
when you press navigation keys, click the screen and perform other actions.

• Use the Backlight icon to change the screen contrast and brightness.
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• Use the Keypad Assignments icon to specify how the navigational buttons act.

4.2.5  Securing Your Information
There are no known problems with passing the netpad through airport security 
machines and other X-rays.

There are several things that you can do to secure your files against other hazards.

• To prevent accidental alterations to the contents of a file, the file can be 
made “read-only”. For more information see Chapter 5: “Files, Folders, 
and Programs”.

• To prevent accidental loss of data, files should be backed up regularly (see 
“Backing Up To Multimedia Cards” on page 40), in case they become cor-
rupted or are deleted accidentally.

• To prevent unauthorized access to sensitive information, a password can be 
set to restrict access to data files.

• Enter owner information so that the netpad can be returned if it is lost. See 
“Entering Owner and Password Information” on page 36.

Note: It is not possible for anyone to copy information from or to your machine 
using Infrared, unless they are able to access its Infrared ‘Send’ and 
‘Receive’ commands on the netpad.



Psion Teklogix netpad Win CE 4.1 User Manual 43

FILES, FOLDERS, AND PROGRAMS 5
5.1  Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
5.2  Moving Around . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 45
5.3  Opening Files, Folders And Programs. . . . . . . . . . . . . . . . . . . 45
5.4  Closing Programs/Files . . . . . . . . . . . . . . . . . . . . . . . . . . 46
5.5  Creating New Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . 46

5.5.1  Creating New Files. . . . . . . . . . . . . . . . . . . . . . 47
5.6  Start Menu - Documents . . . . . . . . . . . . . . . . . . . . . . . . . . 47
5.7  Changing File Attributes . . . . . . . . . . . . . . . . . . . . . . . . . . 47
5.8  Managing Folders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 48
5.9  Checking Memory Use . . . . . . . . . . . . . . . . . . . . . . . . . . 49

5.9.1  What Happens When Memory Is Full? . . . . . . . . . . . 49
5.9.2  Additional Memory And Programs . . . . . . . . . . . . . 50





Psion Teklogix netpad Win CE 4.1 User Manual 45

Chapter 5: Files, Folders, and Programs
Introduction

5.1  Introduction
Windows Explorer is the netpad’s file manager. It is accessible by double-clicking 
on the My Computer icon. 

Note: When you turn the netpad on from a suspend, the programs that were pre-
viously open will still be open and will display on the screen. When you 
turn on the netpad from a cold or warm boot, you will see the Desktop.

5.2  Moving Around 
To move the highlight between the files and folders on the screen: 

click on the names, or use the arrow keys. If there are more files in the folder 
than can be displayed on screen, scroll the screen using the scroll bar.

To view the files on a multimedia card: 
change the current folder by opening the My Computer folder and selecting the 
Storage Card icon.

5.3  Opening Files, Folders And Programs 
To open a file or folder in Windows Explorer: 

double-click, or highlight it and press Enter. In most cases, if a program is 
already running, opening a file associated with that program will open another 
instance of that program.



Chapter 5: Files, Folders, and Programs
Closing Programs/Files

46 Psion Teklogix netpad Win CE 4.1 User Manual

To run a program: 
Open the Start Menu by clicking on the Start button in the bottom left corner of 
the screen. Click on Programs to display all the programs available. Click on 
the name of the program you wish to run.

How can I see which programs are open?
The taskbar across the bottom of the screen displays buttons for programs that are 
open. To switch between programs, click on the button in the taskbar.

5.4  Closing Programs/Files 
To close the current folder: 

tap on the X icon at the top left corner of the screen. When you close all open 
folders, you will see the Desktop.

To close a file: 
use the Close command on the File menu, in the program in which the file is 
open.You will be prompted to save your changes.

You can also close files or programs by selecting the list of open files and programs 
by using the X button in the upper right corner of any window.

5.5  Creating New Folders 
You can keep documents in the My Documents folder under My Computer. It is pos-
sible to create a number of folders inside My Documents, in which to store all your 
files to prevent the My Documents screen from becoming too full.

To create a new folder:

1. Move to the folder in which you wish to create the new folder.

2. Select the New folder command from the File menu, and type in the 
folder name. You can also right-click on the blank space in a folder and 
select New folder from the context menu.

You cannot use the following characters in a folder name: < > : / \ * ? 

If you use netpad files with a PC, you may wish to create folders that match equiva-
lent folders on your PC. This will make transferring files between the netpad and 
PC easier.
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5.5.1  Creating New Files 
You can create files from within programs. As a general rule, open the program in which 
you want to create the file, and select New from the File menu. A file name is suggested. 
If you do not wish to use this, type a name of your own before pressing the OK button.

What names can I use for my files & folders?
You can use most characters in file and folder names including spaces, for example, 
“1997 Purchase Orders and Invoices”. The only characters which cannot be used in 
a file or folder name are: / < > : \ * ? 

You may encounter difficulties if you use very long file names for files stored in 
folders with long names, which are nested within other folders with long names, and 
so on. If you do exceed the maximum allowed length, rename a folder or file to a 
shorter name.

5.6  Start Menu - Documents 
A quick way to find a file that has been recently used is to look in the Documents 
menu on the Start menu. The Documents menu will list up to ten of the most recent 
files opened.

5.7  Changing File Attributes 
You can prevent a file from being accidentally changed by making it a “read-only” 
file. To do this, right-click on the file and select Properties from the context menu. 
Then check the Read-only box.

Files that have been created on a PC and then transferred to the netpad will also be 
“read-only” files.

Note: If you transfer a “read-only” file to another machine, it can be viewed, 
and the “read-only” attribute can be removed.
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5.8  Managing Folders 
To move one or more folders or files from one location to another:

1. First highlight the file(s) or folder(s) to select them. Drag with the 
stylus to select more than one file.

To select all the files/folders in the current folder, use the Select all 
command on the Edit menu. To deselect items, press the Esc key.

2. Select the Cut command from the Edit menu. A dotted line appears 
around the file/folder icon(s).

3. Go to the folder into which the highlighted items are to be moved.

4. Select the Paste command from the Edit menu.

Notes: Moving a folder also moves all the files within that folder.

To copy a file or folder, or multiple files/folders to a different folder: 
follow the earlier instructions, but select the Copy as opposed to the Cut
command from the Edit menu.

To make a copy of a file or folder within the same folder: 
highlight it and select the Copy command followed by the Paste command. A 
new file is automatically created for you using the following naming convention 
(with Wordpad as the example): Copy of Doc1, etc. You can rename the file or 
folder later if you wish.

To rename a single file or folder: 
right-click, select Rename from the context menu, and then type in a new name.

To remove one or more files or folders: 
first highlight them and then either press the Delete key, or select the Delete 
command from the File menu. You can also right-click and select Delete.

Important: If you are deleting folders, remember that the entire contents of 
the folders (including all the other folders contained within them 
and all their files) will also be deleted.
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5.9  Checking Memory Use 
To display the amount of memory remaining: 

double-click the System icon in the Control Panel and select the Memory tab. 
You can see the amount of free memory in the slider bar.

5.9.1  What Happens When Memory Is Full?
When the memory is nearly full, you will see warning dialogues when running pro-
grams to indicate that the netpad’s memory is almost full, and there is not enough 
memory to perform some tasks.

Many actions need just a little free memory in order to work—displaying dialogues, 
menus, etc. These can fail with a message like ‘Memory full’. The netpad will not 
allow you to use all of the available memory; it will always set aside enough 
memory for you to close a program or save an open file to a multimedia card.

Files saved on the internal disk and “open” programs both use memory. So, if the 
memory is nearly full you should be able to free some memory by closing some pro-
grams. You can look at the taskbar to see which programs are running, and then 
close the programs or files that you do not need open.

You can also delete any unwanted files, or move files to a multimedia card or your 
PC to free more memory.
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5.9.2  Additional Memory And Programs 
You can insert multimedia cards into the MMC slot on the right-hand side of the 
netpad. You might use them as additional memory for storing files, or to add more 
programs to the netpad. For details, please refer to “Multimedia Cards” on page 16.

If a multimedia card contains additional programs: 
their icons will be available in the Storage Card folder.

To delete all the files on a multimedia card: 
put it into the MMC slot. Open the Storage icon from the Control Panel. Select 
the partition to format (usually Part00) and then select the Properties button. 
You will see a Format button along with such buttons as Mount and Dismount. 



Psion Teklogix netpad Win CE 4.1 User Manual 51

CONNECTING NETPAD TO A PC 6
6.1  Introduction . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
6.2  Using ActiveSync . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 53
6.3  Getting Help. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 54

6.3.1  Where Can I Find More Help?. . . . . . . . . . . . . . . . 54
6.3.2  Tips On Using ActiveSync Help . . . . . . . . . . . . . . . 54

6.4  Working With Your Files . . . . . . . . . . . . . . . . . . . . . . . . . . 55
6.4.1  Looking At Files On Your netpad . . . . . . . . . . . . . . 55
6.4.2  Copying A File Using Drag And Drop . . . . . . . . . . . 55
6.4.3  Copying A File Using Copy And Paste . . . . . . . . . . . 56
6.4.4  Opening netpad Files From Your PC . . . . . . . . . . . . 57

6.5  Backing Up Your netpad With ActiveSync. . . . . . . . . . . . . . . . . 57
6.5.1  Performing Your First Backup . . . . . . . . . . . . . . . . 57
6.5.2  Performing Regular Backups . . . . . . . . . . . . . . . . 58

6.6  Synchronizing Your netpad . . . . . . . . . . . . . . . . . . . . . . . . . 58
6.6.1  What Is Synchronization? . . . . . . . . . . . . . . . . . . 58
6.6.2  Synchronizing Your netpad . . . . . . . . . . . . . . . . . 58

6.6.2.1  Creating The Partnership . . . . . . . . . . . . . . . 59
6.6.3  Using An Existing Partnership. . . . . . . . . . . . . . . . 61





Psion Teklogix netpad Win CE 4.1 User Manual 53

Chapter 6: Connecting netpad To A PC
Introduction

6.1  Introduction
This chapter explains how to use ActiveSync to copy files between a PC and netpad, 
and how to synchronize items such as Calender, Contacts, Inbox and Tasks files. It 
assumes some basic knowledge of Windows PC operating systems. 

These instructions assume that you have established a link between your PC and 
netpad. See “Setting Up ActiveSync” on page 37 for details on communication 
links.

• Check that a link exists between the netpad and the PC by looking in the 
PC’s System tray in the bottom right-hand corner of your desktop. There 
should be a green circle in the system tray if you have successfully linked, 
as shown. 

If this circle is grey there is no connection. 

• Make sure that your link cable is connected. 

• On the netpad, check the task tray for the blue monitor icon. If there is no 
icon, your unit is not connected. 

6.2  Using ActiveSync
ActiveSync allows Windows Explorer to see files on your netpad, using the Explore 
icon in the ActiveSync window. You can copy your netpad files in most of the ways 
you can copy any normal PC file, including copying or moving files to your PC in 
order to print them. The methods outlined in this chapter are representative of ways 
that you might use Explorer, but are not the only possibilities. 

Note: You can change the look of Explorer using options in the View menu; 
therefore, the appearance of your own screen may vary slightly from 
those shown. 



Chapter 6: Connecting netpad To A PC
Getting Help

54 Psion Teklogix netpad Win CE 4.1 User Manual

6.3  Getting Help 
6.3.1  Where Can I Find More Help? 
ActiveSync includes comprehensive online help, which describes all of the applica-
tion's features and functionality. Please consult the online help for further informa-
tion or guidance on using ActiveSync.

You can display the help topics by double-clicking on the ActiveSync icon on the 
PC system tray and selecting Help from the menu, then Microsoft ActiveSync 
Help.

Note: You can display help for a particular task or dialogue by pressing the 
<F1> key.

6.3.2  Tips On Using ActiveSync Help 
From the Help window, you can find the information you require as follows:

From the Contents tab
you can select a topic from a structured list, e.g. how to perform a particular 
task, or troubleshooting information about how to solve a problem. To find the 
topic you want, double-click on the topic to find the general area of interest, and 
then choose the topic you want to display.

From the Index page
you can find the topic you want by entering any word linked to the subject, such 
as ‘backup’ to find topics containing information about how to back up 
your netpad.

From the Find page
you can search for an exact word or phrase contained within a topic, such as 
‘serial port’ to find all the topics in the online Help containing this phrase.
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6.4  Working With Your Files 
6.4.1  Looking At Files On Your netpad 
Using Windows Explorer, you can open, move, copy and delete files stored on your 
netpad from your PC.

• On the PC, double-click on the Mobile Device 
icon in your PC’s My Computer folder. The 
Mobile Device window opens, displaying icons 
for the files and folders in the My Computer 
folder. 

• Double-click on the netpad’s My Computer 
folder under Mobile Device, to display the files 
and folders on the drive. A folder for the multi-
media card will be present as the Storage Card 
folder.

6.4.2  Copying A File Using Drag And Drop 
1. Go to the folder you want to copy files from. The left-hand pane of the 

Explorer window shows a list of all the disk drives on your PC, along 
with netpad and network drives (if any). You can expand a branch by 
clicking on the  symbol next to it, or close the branch by clicking 
on the  symbol. The right-hand side of Explorer shows the contents 
of the folder selected on the left.

2. Use the scroll bar on the right of the left-hand Explorer pane until you 
can see the drive that contains the folder that you want to copy the file 
from. Left-click and hold to drag the file or folder to copy.

3. Drag the file or folder up the folder list in the left pane, until you can 
see the folder that you wish to copy the file into. If the folder you want 
to copy to is not visible because its branch has not been expanded, 
hover the dragged file over the folder for a second and it should expand. 
This step can be repeated until the folder you want is visible.

4. Drop the file onto the folder name in the left pane, or into the right pane 
if the folder is open, by releasing the left mouse button.
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If necessary, the file is converted into the correct PC format. The file can be used in 
the same way as any other file on your PC.

6.4.3  Copying A File Using Copy And Paste 
Using Windows Explorer, you can copy files between your PC and netpad in the 
same way you would copy files to a floppy disk, or another PC on a network. 
ActiveSync can convert files as they are copied so that you can open them on the 
other computer immediately.

Within Windows, clicking the right mouse button often displays a context-sensitive 
(pop-up) menu – a range of commands relevant to the object that you right-click on. 
In Explorer, you can use these menus to copy files between folders, regardless of 
whether they are on the PC or the netpad.

1. Open Windows Explorer.

2. Navigate to, and expand, the Mobile Device branch of the folder list. 
Find the folder that contains the file you wish to copy to the PC and 
click on it so that its contents are shown in the right-hand pane of the 
Explorer window.

3. Right-click on the file and select Copy from the pop-up menu that 
appears.

4. Navigate to the folder you want to copy this file to, and select it, so that 
its contents (if any) appear in the right-hand pane of the Explorer 
window. Right-click in the right-hand pane of the Explorer window, 
and select Paste from the pop-up menu.
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You can use Windows Explorer to manage files and folders stored on your netpad in 
the same way as you can on your PC’s drives.

Warning: When you delete a file on your netpad from your PC, it is perma-
nently removed from the netpad’s drive. The file cannot be 
retrieved from the Windows Recycle Bin, which only stores files 
deleted from your PC’s drives.

6.4.4  Opening netpad Files From Your PC 
You can open a file on your netpad using a PC application without first having to 
copy it to your PC drive. You can edit the file on your PC and then save it back to 
your netpad when you have finished. To open a file from Windows Explorer, 
double-click on the file icon or press Enter.

When you save the file within the PC application, ActiveSync saves the edited file 
back to your netpad. 

6.5  Backing Up Your netpad With ActiveSync
6.5.1  Performing Your First Backup
You can use ActiveSync to back up all the files stored on your netpad to your PC. 
Keeping backups of your netpad files on your PC means that you have a separate 
copy of all your work that can be restored to your netpad. For example, you can 
restore backed up files to your netpad if you accidentally delete a file, wish to revert 
back to an older version of a file, or need to restore files if you forget to change
the batteries.

To make a backup:
1. Open ActiveSync on the PC by double-clicking on the green circle in 

the task tray.
2. Click on the Tools menu, then on Backup/Restore.

3. Click Back Up Now to start backing up the files on your netpad. 
ActiveSync displays a progress window showing how long the backup 
will take and will inform you when it has completed.
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6.5.2  Performing Regular Backups 
You can set ActiveSync to automatically backup when the device connects, so you 
do not need to back up your netpad manually.

6.6  Synchronizing Your netpad 
6.6.1  What Is Synchronization? 
You can use synchronization to manage information that you wish to keep up to 
date on both your PC and netpad, such as appointments or address book entries. 
When you synchronize, ActiveSync checks the information in your PC program 
with the matching program on your netpad, and then updates the files on both your 
PC and netpad to include the new information. To synchronize, you must set up a 
partnership between the netpad and the PC.

Some examples of synchronization are:

• You add a new appointment in your netpad schedule; the date, time and 
notes for the entry will be copied to your PC scheduler and notify you at the 
appropriate time.

• You change a phone number in your PC address book; it will be amended 
in your netpad’s address book.

• You enter overlapping appointments in your PC and netpad schedules; 
ActiveSync will warn you of the conflict.

6.6.2  Synchronizing Your netpad
This section details the set-up and day-to-day use of ActiveSync to synchronize 
files, e-mail, schedules, and so on, on the PC. The instructions assume some famil-
iarity with the use of Windows, and that you are using ActiveSync (supplied with 
netpad). You must also have a local installation of the e-mail and schedule programs 
to synchronize.

Partnerships are only necessary for synchronization, not to simply copy files from 
the PC to the netpad. Before creating your partnership, note which types of informa-
tion you want to synchronize. You can synchronize the Calendar, Channels, Con-
tacts, Files, Inbox, Pocket Access and Tasks. ActiveSync will tell you which 
desktop applications each of these relates to.
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6.6.2.1 Creating The Partnership
1. Make sure that your netpad is connected to the PC via the serial cable. 

2. Set the PC to listen on the port the serial cable is connected to.

3. On the netpad, check the PC Connection control panel to make sure it 
is set to send to the correct port.

4. On the netpad, click on the Start button, then Programs, then Active-
Sync, and select direct from the ActiveSync menu. This will connect 
the netpad to the PC and bring up the ActiveSync dialogue on the PC.

The New Partnership screen allows you to select what types of information will be 
synchronized.
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5. Check all items to be synchronized. These can be changed after the 
partnership has been created.

6. To customize settings for a particular type of information, click on the 
Settings button. This can also be done after the partnership has been 
created. More information on customized settings can be found by 
referring to ActiveSync’s online help.

7. Click Next.

8. ActiveSync will display the Setup Complete screen with further infor-
mation on using ActiveSync. Click Finish.
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6.6.3  Using An Existing Partnership
Once you have set up the partnership as above, you can use it whenever you wish. 
When the netpad and the PC are connected afterward, it will automatically use the 
current partnership.

To force synchronization, make sure the netpad and the PC are already connected. 
Press the Sync button in the PC’s ActiveSync window. To stop synchronization, tap 
the Stop button.

Note: Hard resetting the netpad will delete the partnership on the netpad. You 
may delete and re-create the partnership on the PC, or create another 
partnership with a new name. Refer to ActiveSync’s online help for more 
details on this operation.
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7.1  Introduction
Before you can use Internet Explorer (the Internet browser) and Inbox (the e-mail 
application), or the optional 802.11 or GSM/GPRS radios on your netpad, some 
basic configuration is necessary. 

For instructions on setting up the 802.11 radio, please refer to “802.11 Radio Con-
figuration”, below.

For details on setting up the modem for GSM/GPRS, please see “GSM/GPRS 
Modem Configuration” on page 68. 

For instructions on using Internet Explorer and Inbox, please refer to “Internet And 
E-Mail Settings” on page 75.

7.2  802.11 Radio Configuration
The following are the basic settings necessary to be able to run the netpad on an 
802.11 radio network.

1. When the netpad is turned on, the radio configuration icon should be in 
the system tray. It may take a few minutes to appear. The configuration 
dialogue will also display.
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2. By clicking on Advanced in the Wireless tab, the user can access the 
settings screen to adjust priority of network connections.

3. The user can add a network and configure WEP for security by clicking 
on the Add button in the Wireless tab. 

4. Selecting Advanced in the Wireless tab will allow the user to configure 
the types of networks to connect to.
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5. By selecting the Name Servers tab, the user can configure DNS and 
WINS servers.

6. By selecting the IP Address tab, the user can configure the IP settings 
for the card.

7. Click on OK to save your settings. These settings can also be changed 
by entering the Control Panel and clicking on Network and Dial-Up 
Connections, then on the adaptor name. 
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7.3  GSM/GPRS Modem Configuration
The following menus provide the configuration settings for the GSM/GPRS radio 
card. For details on setting up a modem through the serial port, please refer to “Con-
necting The Modem” on page 81.

The following information is required from the GSM/GPRS network operator:

• Access Point Name (APN).

• Username and Password (if applicable).

• Some network operators also specify the IP address and NDS settings to be 
used. Please consult the network operator for specific configuration parameters.

1. Open the MMC door (for details, see section 2.2.5 on page 17). Make 
sure the SIM card is not in the slot. If a SIM card is installed, remove 
the battery, and then remove the SIM card as described in “Removing 
The SIM Card” on page 19.

2. Turn the netpad on. The Insert SIM card dialogue box will appear. 
Click OK to close the dialogue.

3. Double-click on the My Computer icon, then on the Windows folder.
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4. Double-click on the GSM Band icon. This will bring up the GSM 
Band Selection menu.

5. Select the correct band setting for your GSM provider. Then click on 
the OK button. The hourglass will appear. When it is gone, use the X 
button to close GSM Band Selection.

6. From the Control Panel, double-click on the APN Manager icon.

7. In the APN Manager, click on the Add button.
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8. Enter the name of the APN, as supplied by the GSM/GPRS service pro-
vider, in the box. Then click on the OK button, and the APN manager 
will disappear. 

9. Remove the battery from the netpad (for instructions, see “Changing 
Battery Packs” on page 15).

10. Insert the SIM card into the SIM card slot (for detailed instructions, see 
“Installing And Removing The SIM Card” on page 17). 

11. Replace the battery into the netpad. The netpad will boot up.

12. The “Registering to Network” message should appear. If registration is 
successful, the message “Setting APN” will be displayed briefly. If reg-
istration fails, the “Could not register with” message will appear. 
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13. Next, open the Control Panel. Double-click on the Dial-Up and Net-
working icon. The following menu will appear.

14. Double-click on the Make New Connection wizard to access the fol-
lowing menu. Type the connection name “GPRS” into the text box, and 
verify that the Dial-Up Connection radio button is selected. Click on 
the Next button.

15. Select Globetrotter from the dropdown list in the Modem screen. 
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16. Click on the Configure button next to the dropdown list, and the follow-
ing menu appears. From the Baud Rate dropdown list, select 115200. 

17. Then click on the Call Options tab to access the following menu.

18. Uncheck the Wait for dialtone before dialing box and click OK. This 
will return you to the Modem selection screen. 

19. Click on the Next button.
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20. The following menu appears. Enter the phone number. Most providers 
use *99# as the GSM/GPRS phone number. 

21. Click on the Finish button. This will return you to the Dial-Up and 
Networking screen. You should now see a connection called “GPRS”. 
Double-click on the GPRS connection. 

22. This will bring up the Dial-Up Connection screen. Click on the Dial 
Properties... button. 
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23. This will bring up the Dialing Properties dialogue box. From the When 
dialing from: dropdown list, select GSM/GPRS. Click OK. 

24. You should be returned to the Dial-Up Connection screen. 

25. Enter your User Name and Password, if your provider has given 
you one. 

Note: Not all providers require a user name or password. 

26. To start a GPRS session, click on the Connect button.

Important: While GSM/GPRS is active, ActiveSync will not be available.
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7.4  Internet And E-Mail Settings
7.4.1  Overview
Before you can use Internet Explorer (the Internet browser) and Inbox (the e-mail 
application) on your netpad, you need to set up certain details. This section covers 
some general questions that people ask about using e-mail and the Internet, and 
provides a glossary of terms. The later sections list the information you will need
to know before you start setting up the netpad, and then provide step-by-step 
instructions.

7.4.1.1 Using The Internet On netpad
You can use your netpad to:

• Access the Internet and view web pages using the Internet Explorer program.

• View locally stored web pages and graphics files.

• Download files, e.g. additional programs for your netpad.

7.4.1.2 Using E-mail On netpad
You can use your netpad to send and receive e-mail messages using either one, or 
both, of the following methods:

Connecting By Telephone Line To A Remote Mailbox
This is for making a ‘live’ connection to your e-mail mailbox via a telephone line 
(without needing a PC). For example, you could access your personal mailbox by 
dialing your Internet Service Provider (ISP), or access your work mailbox by dial-
ling your company's service provider or office mailbox.

What to do next…
If you want to access your work mailbox, you will first need to contact your 
network administrator to find out whether you can make a ‘remote’ (dial-up) con-
nection to your mailbox. See “Types Of E-mail Account” on page 76 to continue.
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Connecting A PC To Access Your Mailbox
This is for connecting directly to a PC that can access your mailbox. Using 
ActiveSync's ‘Inbox Synchronization’, you can write e-mails on your netpad, 
and then connect to your PC to send and receive messages.

How do I do this?
To access your mailbox via a PC, you will first need to install ActiveSync on the 
PC and set up a partnership to use ‘Inbox Synchronization’.

7.4.1.3 Types Of E-mail Account
There are a number of different types of e-mail account. See the list below to find 
out which types of account you can connect to using the e-mail program on 
your netpad.

Personal Dial-up Account
This is most likely a dial-up e-mail account which you’ve signed-up for with an 
Internet Service Provider (ISP).

Which ISPs can I use?
You can use most ISPs which use ‘Internet standard’ methods for connecting to 
your e-mail account. However, some ISPs (such as America Online) use propri-
etary methods for connecting, and cannot be accessed by your netpad (i.e. you 
must use a PC). Move on to ‘Setting up your netpad’ to continue.

Remote (e.g. Office) E-mail Account
This is most likely an e-mail account at your workplace, e.g. using Microsoft 
Exchange or Lotus Notes.

How do I find out if I can use my account?
You will need to find out from your network administrator whether you can 
access your e-mail mailbox using this type of account. If you can, move on to 
“Setting Up Your netpad” on page 78 to continue.
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Web-based E-mail Account
This is an e-mail account that you must connect to using a web browser, e.g. 
HotMail or Yahoo! Mail.

Note: You can’t connect to this type of account using the e-mail program.

To use web-based e-mail, you must first set up your netpad for Internet 
access. You will need to use the Internet Explorer program to access your e-
mail provider’s web site.

7.4.1.4 If You Don’t Have An Internet/E-mail Account
You will require an e-mail account before you can access the Internet, and send and 
receive e-mail messages on your netpad.

• To get a personal e-mail account, you must ‘sign-up’ with an Internet 
Service Provider (ISP). ISPs usually provide an e-mail account as part of an 
Internet access package.

• Most ISPs will provide software (e.g. a CD-ROM) which will help you set 
up Internet access and the e-mail account on a PC.

Important: Some ISPs require that you connect to them using a PC in order 
to sign-up. If you can’t do this, contact the ISP to find out if you 
can sign-up without using a PC. If you have Internet access, see 
www.psion.com/mobile for more details.
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7.4.1.5 Glossary Of Terms 
DNS

The Domain Name System is an address book, which allows computers on the 
Internet to find each other by using ‘IP addresses’ and ‘Hostnames’.

E-mail
An e-mail (electronic mail) is a text message that is sent over the Internet.

Hostname
A human readable version of an IP address, e.g. www.psionteklogix.com could 
be the same as the IP address 194.129.243.153.

IP address
A computer’s unique Internet address, e.g. 194.129.243.153, used by computers 
to communicate with each other.

ISP
Internet Service Providers are companies that provide you with access to the 
Internet. An ISP ‘account’ normally includes the facility to send and receive e-
mail using a personal e-mail address.

POP3/IMAP4
Internet ‘protocols’ (standards) for receiving e-mail.

SMTP
An Internet protocol used for sending e-mail.

TCP/IP
An Internet protocol used by computers to communicate with each other.

7.4.2  Setting Up Your netpad 
7.4.2.1 How To Use Internet Explorer/Inbox
To access the Internet, and send and receive e-mail on your netpad you must have 
the following:

1. An appropriate e-mail account.
To access the Internet and use e-mail, you will need a standard e-mail 
account. 
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2. A modem.
You will need a modem to connect your netpad to the telephone net-
work. You can use the following types of modem with your netpad:

• Standard external PC modems.

• Internal radio modem (GSM variant), see “GSM/GPRS Modem Config-
uration” on page 68 for details.

• Infrared-enabled mobile phones with built-in modems.

3. A telephone connection.
If you are using a standard external modem, you will need to connect 
your modem to a telephone socket. If you are using a mobile phone, 
your network operator will need to enable your SIM (Subscriber Iden-
tity Module) card so that you can make fax and data calls on your 
phone. If your phone has been enabled for fax and data calls, you 
should have two extra phone numbers. Contact your network operator 
if you are unsure whether your phone's SIM card is ‘data-enabled’.

7.4.2.2 Getting Help
If you are having connection problems, you can find information about connecting 
using specific service providers, modems or mobile phones on our web site at 
www.psion.com/mobile.

7.4.2.3 What Information Do I Need? 
Before you can set up your netpad, you will need to find out some information about 
your modem and your Internet e-mail account by:

• Checking any documentation your ISP supplied about your Internet 
account, or contacting your network administrator at work.

• Checking your ISP’s web site for technical support.

• Contacting your ISP by e-mail or phone for technical support.

• Checking the Psion Teklogix web site at www.psion.com/mobile for 
details of worldwide ISPs and to use the ISP configuration wizard.
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Information Checklist 
The checklist in Table 7.1 shows what information you will need to set up your 
netpad. Only your ISP or your network administrator can supply all the information 
required about your Internet e-mail account.

Information You Need Where To Find It Write It Here

Speed at which you should 
use your modem (called the 
baud rate).

Your modem’s documentation.

Phone Number you need 
to dial to connect to your 
ISP (often called a Point of 
Presence or POP).

From your ISP/administrator.

User name for your Inter-
net account.

From your ISP/administrator, 
e.g. “jrook” or “nd44”.

Password for your Inter-
net account.

From your ISP/administrator, 
or you may have chosen this 
yourself.

POP3 or IMAP4 server 
address (for incoming mes-
sages).

From your ISP/administrator 
e.g. “pop3.myisp.com”.

SMTP server address (for 
outgoing messages).

From your ISP/administrator 
e.g. “smtp.myisp.com”.

E-mail Address (your per-
sonal address).

From your ISP/administrator 
e.g. “myname@myisp.coml”.

Table 7.1 Information Checklist
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Some service providers require additional information to ‘log on’ to their server. 
You may need the following information when using some service providers.

7.4.3  Setting Up E-mail On netpad 
If you have collected all the information in the checklist, you are now ready to set up 
your netpad to connect to your ISP.

7.4.3.1 Connecting The Modem 
1. Connect your netpad to the modem using the netpad’s serial cable.

What Do I Need To Do This?
To connect your netpad serial cable to your modem you may require a Psion 
Teklogix modem cable adaptor. You can only use a Psion Teklogix adaptor, 
which can be obtained from your local distributor.

2. Connect your modem to the telephone socket and switch on 
the modem.

Optional Information Where To Find It Write It Here

IP Address (if your ISP’s 
server doesn’t provide one 
automatically).

From your ISP/administrator 
e.g. “194.129.243.153”.

DNS Addresses (primary and 
secondary DNS addresses if 
your ISP’s server doesn’t 
provide them automatically).

From your ISP/administrator 
e.g. “123.255.78.90” and 
“123.255.78.92”.

Mailbox Login (if different 
from your Internet account 
user name).

From your ISP/administrator.

Mailbox Password (if differ-
ent from your Internet account 
password).

From your ISP/administrator, 
or you may have chosen this 
yourself.

Table 7.2 ISP Additional Information
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7.4.3.2 Setting Up Dialling 
When you connect to the Internet, your netpad will need to dial your service pro-
vider’s telephone. You can set up different dialling ‘locations’ so that your netpad 
knows how to dial the number correctly, e.g. if you're dialling from the ‘office’ loca-
tion, you might need to add a ‘9’ before the number you want to dial.

To set a dialling location:

1. Open the Control Panel by clicking on Start, then Settings, and then 
Control Panel.

2. Open the Dialing icon  to display the dialing settings.

3. The netpad comes with two default locations, Home and Work. Adjust 
these to suit your needs by selecting the location in the dropdown box 
and editing the associated information. For more control over dialing 
patterns, push the Dialing Patterns button.

If you don’t want to use any of these pre-defined locations, you can add a new loca-
tion. It will appear selected in the drop-down list, ready to edit.

4. Tap on New and enter the name of the new location.

5. The dropdown will display the new location. Edit as described above.

6. Tap OK when you have finished setting up your dialing location.
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7.4.3.3 Setting Up The Internet Service
To set up a new dial-up connection:

1. Open the Control Panel.

2. Open the Dial Up Networking icon.  

3. Double-click on the Make New Connection icon. 

4. Enter the name for the dial-up connection, usually the name of the ISP. 
The radio button should be next to Dial-Up Connection. Click Next.

7.4.3.4 Setting Up The Modem
After you have named your connection, you will set and configure your mode.

5. From the dropdown, select the correct modem.

6. Click on Configure to open the modem properties. The default settings 
for the modem should only be changed if the modem manufacturer’s 
instructions indicate such.

7. After selecting and configuring a modem, click Next to continue to the 
Phone Number screen. Set the phone number. Click Finish.

8. The Dial-Up Networking screen should show your new connection 
with the dial-up icon.
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9. To connect, double-click on the connection. You must enter your user 
name and password.

10. When you have finished entering the settings, tap Connect to dial the 
connection.

7.4.3.5 Setting Up The E-mail Program 
Once you have set up your Internet service, you can set up your e-mail account in 
the e-mail program.

To create a new account in e-mail:

1. On the netpad, click on the Start button, then Programs, then 
Network, and select Inbox from the menu.

2. Select Inbox from the Options command on the Services menu.

3. On the Services tab:

• Click Add.

• Select the type of service to use. You will be asked to configure settings 
and enter information based on that service. Refer to Microsoft’s online 
help for more information.

• After configuring the service and clicking Finish, you should see your 
service under Installed Services. Click OK.
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8.1  Introduction
The following optional accessories are available from Psion Teklogix. These acces-
sories are compatible with all netpad models in the netpad product range. Please 
check the Psion Teklogix web site at www.psionteklogix.com for updates to this list.

8.2  Accessory Product List

ACCESSORY PRODUCTS PART NUMBER MODEL 
NUMBER

DOCKING STATION ITEMS
Docking Station Product Packs
The Desktop Docking Station provides charging and 
simultaneous data communications via the RS232. See 
Chapter 3: “Docking Station” for details.
All Docking Station packs are supplied with a Power 
Supply Unit, RS232 Serial Cable & AC Power Leads 
for the following regions:
• UK and Europe 1201 0039 0002
• Australia, New Zealand & Japan 1201 0040 0002
• North America 1201 0044 0002

netpad Docking Station 
This item is offered as a replacement for a lost or 
damaged dEsktop Docking Station. It does not include 
the PSU or leads.

1201 0041 0001

Universal PSU for Docking Station
This item is offered as a replacement for lost or 
damaged PSUs. It does not include the mains lead.

A2032 0047 0002

In-vehicle Docking Station
The In-vehicle Docking Station provides a secure 
method for mounting and powering the netpad in vehi-
cles from 12VDC. See page 90 for details.

1201 0050 0001
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ACCESSORY PRODUCTS PART NUMBER MODEL 
NUMBER

BATTERIES AND CHARGERS
875 mAh Li Ion Standard Battery A2202 0002 0002

1400 mAh Li Ion Enhanced Battery A2202 0001 0002

netpad Portable Battery Charger
The Portable Battery Charger provides a convenient 
method of charging a single battery pack from mains or 
12VDC vehicle power.

NP3001

netpad 4-Bay Battery Charger
The 4-Bay Battery Charger provides a convenient 
method of charging a up 4 battery packs from 
AC power.

NP3004

CARRYING CASES
There are a range of carrying cases that offer methods of carrying and protecting the 
netpad. The carrying cases are available in the following configurations.
Soft Carrying Case (for netpad 1100) c/w shoulder 
strap.

1202 0020 0001

Soft Belt Holster (suitable for all netpads) c/w shoul-
der strap.
*Important: See “Use Of The Soft Belt Holster” on page 13.

1202 0023 0001

Soft Carrying Case (for netpad 1200) c/w shoulder 
strap.

1202 0026 0001

Soft Carrying Case (for netpad 3500) c/w shoulder 
strap.

1202 0025 0001
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ACCESSORY PRODUCTS PART NUMBER MODEL 
NUMBER

CABLES
RS 232 Serial Cable (9-pin Female D-type to netpad) A2203 0003 0002

RS 232 Adapter Cable
The RS232 Adapter Cable has 9-pin Male D-type for 
connection to the netpad R232 port and can be used to 
connect serial peripherals such as printers, modems or 
cell phones to the netpad

A2888 0015 0003

Replacement Power Leads are available for the fol-
lowing countries:
• USA power lead A2032 0036 0001
• UK power lead A2032 0037 0001
• Euro power lead A2032 0038 0001
• Japan power lead A2032 0041 0001
• Australian/New Zealand power lead A2032 0042 0001

MISCELLANEOUS
Replacement Stylus (Pack of 10) 1208 0015 0001

MMC Card Reader (Parallel Port Interface) A2888 0016 0001

16 MB MMC Card A2202 0018 0001

netpad Win CE Developer’s CD
The netpad Win CE developer’s CD contains all of the 
development tools for the netpad.
The latest versions of the files available on the Devel-
oper’s CD are available for download from the netpad 
Developer’s Resource web site at: 
http://partners.psionteklogix.com/netpad-pdk
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8.3  The In-vehicle Docking Station
The netpad in-vehicle docking station provides a durable and flexible solution for 
mounting the netpad in vehicles. It offers the following features:

• Highly adjustable. 
The mounting arm can be adjusted to provide the ideal viewing angle, no 
tools required. 

• Small footprint.
It requires less than a 62 mm x 62 mm (2.5 in. x 2.5 in.) mounting area.

• Securely mounted to a range of surfaces.

• Supports landscape or portrait orientation.

• One-handed release mechanism.

• Charging and Data communications. 

• One RS232 port.
For connection to peripherals such as GPS receivers, radio modems or cell 
phones.

• Compact 12 VDC power supply.
With cigarette-lighter adaptor (which can 
be removed for permanent connection to 
vehicle power).
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9.1  General Troubleshooting Tips
You should read this chapter if you have any questions or experience problems 
using your netpad.

9.1.1  Times Aren’t Correct In The Time Program
This is likely to be because of “daylight saving” or “summer time” settings (where 
clocks are put forward for the summer months).

The dates that clocks are set to change vary from country to country, and sometimes 
even within a country; some countries do not use summer times at all. Therefore, the 
netpad clock will not change automatically on the date that the clocks change. You 
will need to make sure that each zone is set to use its “summer time” setting when 
the clocks change in those countries.

9.1.2  If You Forget Your Password 
If you forget the machine password, you will not be able to use the netpad until 
you perform a “hard reset”. All the files on the internal disk will be lost and 
cannot be retrieved.

9.1.3  The netpad Doesn’t Turn On/Off 
If the netpad doesn’t seem to turn on:

• Check the screen contrast to make sure it isn’t set too low.

• Recharge the main battery. If you continue to use the netpad when the main 
battery is low, it will eventually not have enough power and the netpad will 
switch off. You will not be able to switch it on again until you place the 
netpad in the docking station to recharge the battery or replace the main 
battery with a charged one.

If the netpad doesn't seem to turn off:

• Check the automatic switch off time using the Power icon from the 
Control Panel.
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9.1.4  How To Reset The netpad 
If you find that you cannot exit a program normally, right-click on the taskbar and 
select Task Manager from the context menu. Select the task that appears to be unre-
sponsive and click on the End Task button.

If this does not work, or if your netpad appears to have “locked up”, you can always 
perform a “soft reset”. This should restart your netpad while preserving most of 
your information.

It is worth trying a soft reset if the keys on the netpad do not appear to respond, or if 
the netpad appears to switch on and you are sure that the batteries are good, but the 
screen is otherwise blank.

To perform a soft reset: 
gently press the stylus onto the reset switch. This is located inside the Card Slot 
door cover to the side of the MMC slot.

After a soft reset, any changes to open files will be lost. Your other files on the inter-
nal disk will almost always be safe.

It is possible (although unlikely) that a program failure causes the reset to lose the 
information on the Internal disk; it could even prevent the reset from working at all. 
If this happens, you will have to perform a “hard reset”.

To perform a hard reset: 
1. Remove the netpad from the docking station.
2. Remove the main battery.
3. Press and hold down the On/Off button (on the top of the unit).

Card Slot Door Latch

MMC Card

Reset
Button
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4. While continuing to hold down the On/Off button, press and release the 
Reset button. 

5. Release the On/Off button. 

Important: A hard reset resets the netpad completely, and all information on 
the Internal disk will be lost.

9.1.5  Can’t Place The netpad In The Docking Station 
If you are having difficulty putting the netpad in the docking station, you may be 
attempting to insert it upside down. Push the netpad into the docking station until 
you hear a click.

9.2  ActiveSync Connection Problems 
Using Windows95/98/NT 4.0

This section is a guide to troubleshooting connection problems between a netpad 
and a PC running Windows 95/98/NT 4.0 and ActiveSync. It also presumes you 
have already gone through the online help documents that come with ActiveSync, 
and still have no success in linking. A basic knowledge of using the netpad and 
Windows 95/98/NT 4.0 is necessary. For information about using Windows 
95/98/NT 4.0, check your Windows manual or contact the Windows 95/98/NT 4.0 
helpline. 
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9.2.1  Tips When Installing ActiveSync
Close any other programs that are running. This includes virus checkers, uninstall-
ers, floating toolbars etc.

If you need to re-install ActiveSync, make sure you uninstall the previous version first:

1. Click on the Start button and select Settings, then Control Panel. 

2. Double click the Add/Remove Programs icon. Select ActiveSync in 
the list and then click the Add/Remove button. 

Important: You must re-start your PC before re-installing ActiveSync or you 
will experience problems.

.
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9.2.2  Basic Troubleshooting For Your netpad
1. Close down all applications. To see all active programs, look on the 

taskbar. Each program running will have a button. The programs can be 
activated then closed normally, or if necessary, you can right-click on 
the program’s taskbar button and choose Close from the context menu.

2. Check that the PC Connection setting in the Control Panel is enabled 
and set to the correct serial port. Note that a partnership must already 
exist for the Infrared port to use ActiveSync correctly.

3. Perform a soft reset on the netpad. 

9.2.3  Basic Troubleshooting For Your PC
1. Close down any other open applications in Windows.

2. If you have a laptop: 

• Make sure you have no PC Cards (PCMCIA cards) plugged in. 

• Most laptops have power-saving features that disable the COM ports. 
Turn these power saving options OFF. 

• If your PC has an Infrared port, make sure it is disabled and your 
serial/COM ports are enabled. Psion Teklogix can support you with any 
of these issues. Check the laptop’s manual or contact the manufacturers 
support department to get these issues rectified.

3. The ActiveSync Connection server icon is in the bottom right-hand 
corner of your PC Screen. When you are not connected, it is a grey 
circle. When you have made a successful connection, it becomes a 
green circle.

• Right-click the ActiveSync icon and 
choose Connection Settings from the 
context menu.
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• Make sure that the correct connection type is checked.

• It is possible for ActiveSync to conflict with a modem or mouse. Symp-
toms are the mouse pointer intermittently locking up or software that 
uses the modem intermittently freezing. Check your PC’s device 
manager for conflicts.

4. If you are using Windows NT 4.0, check that you have at least 
Service Pack 3 installed. If necessary, install it or contact your Systems 
Administrator.

9.2.4  Device Conflicts
To check for device conflicts:

1. Click on the Start button, select Settings and then Control Panel. 

2. Double-click on the System icon.

3. On the Device manager page of the System properties dialogue, check 
for icons marked with a symbol.
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Note: This symbol means that the marked device is conflicting with another 
device. If a modem or COM port is conflicting, this could be a cause of 
ActiveSync not connecting. Contact the person or organization that sup-
ports your PC to resolve the conflict.

4. There is no Device Manager in Windows NT 4.0. The closest is a list of 
IRQs, I/O ports and DMA channels. These are accessed by the Start 
button, selecting Programs, then Administrative Tools (Common), 
then Windows NT Diagnostics. Select the Resources page in the 
Windows NT Diagnostics dialogue box. If you do not have this option 
or you are in any doubt about it, you should contact your Systems 
Administrator.
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9.2.5  Fax/Modem On COM 1/2/3/4
If you have a Fax/Modem using COM Port 3 or 4, and ActiveSync on COM 1 or 2 
(or vice versa), you may have trouble when trying to connect with the netpad.

Because of the way a PC handles COM ports, COM1 and COM3 are ‘linked’, as are 
COM2 and COM4. Specifically, they share the same Interrupt Request (IRQ). 

In practice, this means that if you have a modem on COM3, it may conflict with the 
netpad on COM1 (and the same applies for COM4 and COM2). The solution is to 
try using ActiveSync on a different port or to assign a different IRQ. 

You can check the COM port properties by following the steps above to get to the 
Device Manager page and double-clicking on the COM port.

Again, if you are in any doubt about whether you are able to do this safely, you 
should contact the person or organization that supports your PC.
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If you have an external modem and have unplugged it to use the Psion Teklogix 
serial cable on the same port, you will not get a connection. Windows 95/98/NT 4.0 
reserves this port for use with the modem and so you will have to use another port.

9.2.6  Temp Folder
The ActiveSync connection can be affected if you have not specified, or have incor-
rectly specified, your Temp folder. To specify this: 

1. Click Start and 
select Run. Type 
sysedit in the dia-
logue and click OK.

A screen with multiple windows is displayed.
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2. Click on the AUTOEXEC.BAT title bar. 

3. Look in this window to see if it has a line that starts SET TEMP=. If 
this line exists, check that the folder that it points to exists, and create 
the folder if not. 

If this line doesn’t exist, place the cursor on a new line and type SET 
TEMP=C:\TEMP.

Close the window and choose Yes when asked if you want to save the 
changes.

4. Create a folder on the root of your C drive and call it Temp.

5. Finally, restart your PC.
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9.3  Troubleshooting ActiveSync
Synchronization Problems

This section discusses various problems that may be encountered when synchroniz-
ing using a partnership. 

Some familiarity with these applications, Windows 95/98/NT 4.0, and your netpad 
is assumed. You will also need a full installation of your PC PIM. 

Note: This section should be used in conjunction with the manual to setting up a 
synchronization for each application.

The majority of synchronization problems are caused by setting up a synchroniza-
tion incorrectly. Please make sure you have read the appropriate sections in 
Chapter 6: “Connecting netpad To A PC” first. These explain the correct way to set 
up a synchronization.

9.3.1  Basic Troubleshooting For Synchronization Problems
Some common causes of sychronization errors include incorrect settings, and 
e-mail issues. 

Incorrect settings can result from the wrong program being associated with a partic-
ular synchronization event. If you have Outlook installed on your PC, ActiveSync 
will most likely automatically assume that Tasks, E-mails, etc., should all be associ-
ated with Outlook. Verify that the programs you are using are associated with the 
type of synchronization you require.

E-mail issues usually stem from conflicts in address books, and conflicting settings 
in ActiveSync itself. To verify that e-mails get synchronized to and from the netpad 
correctly, verify that the e-mail addresses in the netpad outbox are valid. ActiveSync 
will provide some error text on synchronization to help you detect such problems. 
Conflicting settings in ActiveSync can result in e-mails being transferred as headers 
only, or without attachments. Check the settings for the ActiveSync service in Inbox 
on the netpad to resolve this issue.



Chapter 9: Troubleshooting the netpad
Other Things To Try

104 Psion Teklogix netpad Win CE 4.1 User Manual

9.3.2  Other Things To Try
1. Delete and recreate your partnership in ActiveSync.

When ActiveSync connects to a machine using a partnership for the 
first time, it uses the name “WindowsCE”. Every subsequent partner-
ship created after the first asks you to enter a name for that machine. 
Partnerships register details about your netpad on your PC. Sometimes 
this information can become corrupt. 

• Open ActiveSync by double-clicking on the ActiveSync icon in the 
PC’s system tray. This will bring up the ActiveSync dialogue. 

• Click on the File menu and select Delete Partnership from the menu. 
The Delete Partnership menu item will not be available if there are no 
partnerships.

If you have deleted all the partnerships, the next time you connect your 
netpad, the partnership will be created as “WindowsCE”.

2. Make a new backup and recreate any synchronizations.
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APPENDIX A
SUPPORT SERVICES AND WORLDWIDE OFFICES

Psion Teklogix provides a complete range of product support services to its custom-
ers worldwide. These services include technical support and product repairs. 

A.1  Technical Support
Technical Support for Mobile Computing Products is provided via e-mail through 
the Partner Program website. To reach the website, go to www.psionteklogix.com 
and click on the Partner Program link, which takes you to the Partner Program page. 
Then click on the Log-in button or the Register button, depending on whether you 
have previously registered for Teknet or the Partner Program. (Your UserID and 
password are the same for TekNet and the Partner Program.)

A.2  Product Repairs
International

For product repairs, please contact your local Psion Teklogix office (see 
page A-2). 

Canada/U.S.A
Canadian and U.S. customers can receive access to repair services, by calling 
the toll-free number below, or via our secure website. 

Note: Customers calling the toll-free number should have their Psion Teklogix 
customer number or trouble ticket number available.

Voice: 1 800 387-8898 (press option “2”)

Fax: 1 905 812-6304

Web Site: http://service.psionteklogix.com
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A.3  WORLDWIDE OFFICES

COMPANY HEADQUARTERS 
AND CANADIAN SERVICE CENTRE

Psion Teklogix Inc.
2100 Meadowvale Boulevard
Mississauga
Ontario
Canada L5N 7J9
Tel: +1 905 813 9900
Fax: +1 905 812 6300
E-mail: salescdn@psion.com

INTERNATIONAL SUBSIDIARIES

Psion Teklogix GmbH
Jakob Kaiser Straße 3
D-47877 Willich Münchheide
Deutschland
Tel: +49 2154 9282 0
Fax: +49 2154 9282 59
E-mail: info@teklogix.de

Psion Teklogix S.A.
La Duranne
135 Rue Rene Descartes
BP 421000
13591 Aix-En-Provence
Cedex 3; France
Tel: +33 (0) 4.42.908.809
Fax: +33 (0) 4.42.908.888
E-mail: tekeuro@psion.com

Psion Teklogix (UK) Ltd.
Bourne End Business Centre
Cores End Road
Bourne End
Buckinghamshire SL8 5AR, England
Tel: +44 1628 648800
Fax: +44 1628 648810
WWW: www.teklogix.co.uk
E-mail: tekuk@psion.com

Psion Teklogix AB
Stora Badhusgatan 18-20
411 21 Göthenburg, Sweden
Tel: +46 31 13 15 50
Fax: +46 31 13 57 80
E-mail: info@teklogix.se

NORTH AMERICAN HEADQUARTERS 
AND U.S. SERVICE CENTRE

Psion Teklogix Corp.
1810 Airport Exchange Boulevard
Suite 500
Erlanger, Kentucky
USA 41018
Tel: +1 859 371 6006
Fax: +1 859 371 6422
E-mail: salesusa@psion.com

Psion Teklogix Finland
Metsänneidonkuja 8
02130 Espoo
Finland
Tel: +358 9 4307 8390
Fax: +358 9 4307 8395
E-mail: tekeuro@psion.com

Psion Teklogix Danmark
Vesterballevej 4-6
7000 Fredericia
Danmark
Tel: +45 76 24 0133
Fax: +45 75 94 4679
E-mail: tedk@psion.com

Psion Teklogix Italia S.r.I
Via Galilei, 47
20092 Cinisello Balsamo
Milan, Italy
Tel: +39 2 6604 5410
Fax: +39 2 6604 5412
E-mail: tkxitalia@psion.com

Psion Teklogix Inc. (Singapore)
583 Orchard Road
# 15-01 Forum
Singapore 238884
Tel: +65 735 8108
Fax: +65 733 5990
E-mail: intl@psion.com

Psion Teklogix de Mexico, S.A. de C.V.
Sierra Mojada 626, 2º Piso
Col. Lomas Barrilaco, C.P. 11010
Mexico, D.F., Mexico
Tel: +52 55 5 327 1124
Fax: +52 55 5 327 1123
E-mail: salesusa@psion.com

Psion Teklogix do Brasil, Ltda.
Al. Casa Branca, 851 - conj. 101 e 102
São Paulo - SP - 01408-001
Brasil
Tel: +55 11 3064 0868
Fax: +55 11 3068 8198
WWW: www.teklogixbrasil.com.br
E-mail: tekbr@psion.com

Chile Psion Teklogix International Inc.
Avenida Vitacura 2909, Oficina 703
Las Condes
Santiago, Chile
Tel: +56 2 334 9344
Fax: +56 2 233 3868
E-mail: ventas@psion.com

Psion Teklogix de Argentina, S.A.
Avenida Moreau de Justo 1180
Piso 1, Oficina C-105
Buenos Aires 1107
Argentina
Tel: +54 11 4343 0193
Fax: +54 11 4343 6310
E-mail: tekar@psion.com
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Psion Teklogix España, S.L.
Cityparc Ronda de Dalt
Ctra. Hospitalet 147-149
Edificio Atenas 2° 3ª
08940 Cornellà de Llobregat (Barcelona)
España
Tel: +34 9 3475 0220
Fax: +34 9 3475 0230
E-mail: teklogix@apdo.com

Psion Teklogix Africa
Postnet Suite 39, Private Bag x11
Halfwayhouse, 1685 Ground Floor East
Waterfall Edge Phase 2, Waterfall Park
Bekker Road MIDRAND 1685
South Africa
Tel: +27 11 805 7440/1/2
Fax: +27 11 805 7444

Psion Teklogix Systems India Pvt. Ltd.
M-74, 1st Floor, “M” Block Market
Greater Kailash-Il
New Delhi - 110048
India
Tel: +91 11 2621 9257
Fax: +91 11 2621 9076
E-mail: tekind@psion.com

Psion Teklogix B.V.
Venrayseweg 57, 
5928 NZ Venlo
Nederlands
Tel: +31 77 32400 44
Fax: +31 77 32400 53

Psion Teklogix Taiwan Co., Ltd.
15FL-5, No. 366 Boai 2nd Road,
Tzuo Ying District, KAOHSIUNG 813
Taiwan, R.O.C.
Tel: +886 7 558 2028
Fax: +886 7 558 3328
E-mail: jerry.chen@teklogix.com

Psion Teklogix Benelux
Nieuwe weg 1, 
2070 Zwijndrecht
Belgium
Tel: +32 (0)3 250 22 00
Fax: +32 (0)3 250 22 20
E-mail: info@psionteklogix.be

A.4  WORLDWIDE WEB

www.psionteklogix.com
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Boldface indicates a menu or sub-menu name.
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troubleshooting  103
using  40

additional programs  7
antenna installation  12
APN Manager  69
applications installed on the netpad  4
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D
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device conflicts  98
dialling, setting up  82
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buttons  27
using  26

dial-up account  76
Dial-up and Networking  71
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disks
viewing files  45

displaying
amount of memory  49
control panel  41

DNS, definition of  78
docking station  29, 31

in-vehicle  90
product packs  87
Universal PSU  87

drop rating  6

E
e-mail  75

account  77
checklist  80
optional information  81
remote account  76
setting up  63, 81, 84
types of account  76
web-based account  77

e-mail, definition of  78
Emissions Information, Canada  xiii
entering

information  25
owner information  36

Ethernet
connection  39

F
fax/modem  100
figure

Antenna Insertion And Removal  12
Back Of netpad  11
Battery Insertion  14
Location Of Scanner  12
Location Of SIM Card And MMC  17
MMC insertion
netpad Front  11
Removal Of SIM  19

files  25, 43
changing attributes  47
copying  48
memory use  49
moving around  45
naming  47
navigating  24
opening  45, 46
viewing on disk  45

folders  43
closing  46
copying  48
managing  48
moving around  45
naming  47
navigating  24
opening  45

G
Globetrotter Option card  71
glossary of terms  78
GSM/GPRS

antenna  12
modem configuration  68

GSM Band Selection  69

H
hard reset  22, 94
hostname, definition of  78
How to

check the battery power  15
reset the netpad  94
see which programs are open  46
use Internet Explorer/Inbox  78

humidity  7

I
icons

command  21
system command  21

IMAP4, definition of  78
Infrared

connection  39
device safety  xiii

integrated scanner, safety  xiii
internal backup battery  16
Internet  75

account  77
setting up  63, 83

in-vehicle docking station  90
IP address, definition of  78
IP rating  6
IrDA See Infrared
ISP  81
ISP, definition of  78

K
keyboard
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display  21
entering information  25

L
lithium-ion battery safety  xiv

M
magnetic fields  7
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connecting through PC  76
connecting to remote by modem  75

Make New Connection  71
memory

card, additional programs  50
displaying  49
file sizes  49
use, checking  49

menus  21, 26
MMC  29

accessories  89
backup  40

Mobile Device  55
modem

connecting  81
setting up  83
troubleshooting  100

moving
highlight between files/folders  45
to a program  46

multimedia cards See MMC

N
naming

files  47
folders  47

netpad
care and safety  5
connecting to modem  81
connecting to PC  40
overview  4

netpad Front  11

O
offices list  A-2
on-screen keyboard  See keyboard
opening

files  45
folders  45

operating temperature  6

P
partnerships  38
partnerships, creating with ActiveSync  59
personal dial-up account  76
POP3  78
POP3, definition of  78
Portable Battery Charger  88
power management  14
printing, using PC  53
programs  25, 43

additional  50
moving to  46
opening  45, 46
starting  24

programs, additional  7

R
remote e-mail account  76
resetting netpad

hard  22, 94
soft  22, 94

restoring files from backup  41

S
safety

battery  xiii, xiv
Infrared  xiii
instructions  xii
integrated scanner  xiii
summary  vii

scanner  23
screen

overview  21
rotation  35

screen, caring for  5
securing your information  42
setting

time, date, home city  36
setting up

ActiveSync  37
dialling  82
e-mail  63, 81, 84
Internet service  63, 83
modem  83

SIM, installation  17
SMTP, definition of  78
soft reset  22, 94
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storage temperature  6
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replacement  89
stylus, using  20
Subscriber Identity Module See SIM
switching on  12
synchronizing  58
synchronizing files

ActiveSync  58–61
system command icon  21

T
TCP/IP, definition of  78
temp folder  101
text conventions  4
third party applications  7
time  36
toolbar  21
transferring information  38
troubleshooting  91

ActiveSync  95, 103
docking station  95
fax/modem  100
for your netpad  97
for your PC  97
general tips  93
netpad basics  97
netpad in the docking station  95
netpad on/off  93
passcode (password)  93
synchronization problems  103
temp folder  101
world times  93

turning on/off  20

U
Universal PSU  87

W
website address  A-3
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4-Bay Battery Charger  88
802.11

antenna  12
radio configuration  65
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